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Warning !

1. Battery
Batteries on board are consumables.
The life time of them are not guaranteed.

2. Fless solution with HDD
The specification & limitation of HDD should be considered carefully when
the fanless solution is implemented.

3. We will not give further notification in case of changes of
product information and manual.

4. SATA interface does not support Hot SWAP function.
5. There might be a 20% inaccuracy of WDT at room temperature.

6. Please make sure the voltage specification meets the requirement
of equipment before plugging in.

7. Caution! Please notice that the heat dissipation problem could cause the MB
system unstable. Please deal with heat dissipation properly when
buying single MB set.

8. Please avoid approaching the heat sink area to prevent users from
being scalded with fanless products.

9.  If users repair, modify or destroy any component of product unauthorizedly,
We will not take responsibility or provide warranty anymore.

10. DO NOT apply any other material which may reduce cooling
performance onto the thermal pad.

11. Itis important to install a system fan toward the CPU to decrease
the possibility of overheating / system hanging up issues,
or customer is suggested to have a fine cooling system to dissipate heat
from CPU.




kK Hardware Notice Guide

1. Before linking power supply with the motherboard, please attach DC-in adapter to

the motherboard first. Then plug the adapter power to AC outlet.

Always shut down the computer normally before you move the system unit or

remove the power supply from the motherboard. Please unplug the DC-in adapter first
and then unplug the adapter from the AC outlet.

Please refer photo 1 as standard procedures.

2. In case of using DIRECT DC-in (without adapter), please check the allowed range
for voltage & current of cables. And make sure you have the safety protection for
outer issues such as short/broken circuit, overvoltage, surge, lightning strike.

3. In case of using DC-out to an external device, please make sure its voltage and
current comply with the motherboard specification.

4. The total power consumption is determined by various conditions
(CPU/motherboard type, device, application, etc.). Be cautious to the power cable
you use for the system, one with UL standard will be highly recommended.

5. It's highly possible to burn out the CPU if you change/ modify any parts of
the CPU cooler.

6. Please wear wrist strap and attach it to a metal part of the system unit
before handling a component. You can also touch an object which is
ground connected or attached with metal surface if you don't have wrist strap.

7. Please be careful to handle & don't touch the sharp-pointed components on
the bottom of PCBA.

8. Remove or change any components form the motherboard will VOID the warranty of
the motherboard.

9. Before you install/remove any components or even make any jumper setting
on the motherboard, please make sure to disconnect the power supply first.
(follow the aforementioned instruction guide)

10. "POWERON after PWR-Fair” function must be used carefully as below:

When the DC power adaptor runs out of power, unplug it from the DC current;
Once power returns, plug it back after 5 seconds.

If there is a power outage, unplug it from the AC current, once power returns,
plug it back after 30 seconds. Otherwise it will cause system locked or made

a severe damage.

Remark 1:

Always insert/unplug the DC-in horizontally & directly to/from the motherboard.
DO NOT twist, it is designed to fit snugly.

Moreover, erratic pull / push action might cause an unpredictable damage to the
component & system unit.

___________________________________________________________________________|
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Photo 1 Insert

Unplug
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Chapter-1

General Information

The CI770A/C is All-In-One board which could apply to the use of Networking,POS

or Automation Control Board. It is designed to combine all necessary input and output
affects interfaces, which makes it to be ideal All-In-One control board for the demand of
Networking, POS and Automation Control applications.

High-performance and power-efficient communication platform, the embedded
motherboard of CI770A/C is specially designed for advanced POS systems where the
economical use of power is in high demand. Also, the high performing

CI770A/C comes with two DDR3 1333 / 1600 MHz SO-DIMM slots with up to 16GB
memory and four SATA ports. This motherboard will ensure the high performance levels
required for today's most popular POS/Automation control applications including POS,
ATM, and Panel PC applications.

CI770A/C has Intel LAN chipset with 10/100/1000 Mbps Ethernet for seamless broadband
connectivity. With the Wake-On LAN function and the PXE function in BIOS for Intel LAN
chipset, it is perfect control board for networking devices

CI770A/C also supports with multi-COM ports of five RS232 and one RS232/422/485 to
meet the needs of connectivity for multiple COM ports. In addition, there are multi-ports of
Hi-Speed USB 3.0/2.0 to enhance the host controller interface which will ensure the high
performance level and flexible expansion. The CFast Card socket supports SATA interface
2.0. A single Flash chip holds the system BIOS, and you can change the Flash BIOS by
the Utility Update.

The supported display interfaces include DVI-D, VGA, LVDS and HDMI. With a small
footprint of only 200 x 150 mm and advanced performance in both computing and
graphics, this board meets the requirement of system developers in the gaming, POS,
digital signage, and server market segment.



1-1 Major Feature

1
2
3
4
5.
6
7
8
9

10.
11.
12.

13.

Intel Mobile Ivy Bridge processor in Socket G2 package (rPGA988B)

Intel Panther Point Platform Controller Hub (PCH) QM77 and Integrated Graphic Chip
Support 2 x DDR3 SO-DIMM socket (up to 16GB)

Support 2 x Intel GbE

18/24 bits dual channel LVDS Interface on Board

Support 1 x CFast Card Socket on Board (option)

Support 4 x SATA ports (2 x SATA 2.0 and 2 x SATA 3.0)

Support 2 x PCle mini card for USB and PCle interface

On board DC-IN +12V Power Supply

Compact PCB Dimension: 200 x 150 mm

2 x SIM Card Socket (for 3G module use)

USB interface Touch screen controller, support 4-, 5-, 8- wire Analog Resistive touch
screen, Resolution is up to 2048 x 2048 (option)

Support 4 x external USB 3.0/2.0 & 5 x internal USB2.0



1-2 Specification

o g M w e

10.
11.
12.
13.
14.

15.

16.
17.

18.

19.

20.

21.

CPU: Intel Mobile Sandy Bridge processor in Socket G2 package (rPGA988B)
Chipset: Intel Panther Point Platform Controller Hub (PCH) QM77

Memory: 2 x DDR3 SO-DIMM socket (up to 16GB)

Graphics: Integrated with Intel Mobile Sandy Bridge Processor

SIO and UARTSs: Fintek F71869A and F81216AD I/O chipset

NAND flash memory:

Support One CFast card socket type Il for SATA interface

On board SATA SSD 2/4/8/16/32/64 GB (Option)

SATA: 4 x SATA ports (2 x SATA 2.0 and 2 x SATA 3.0)

LAN Interface: One Intel 82579LM GbE LAN PHY and one Intel 82574L GbE LAN
Storage Device: 1 x 24pin CFast card socket (option)

Serial Port: 5 x RS232 and 1 x RS485 / 422/ 232

USB: 4 x external USB 3.0/2.0 & 5 x internal USB2.0

Sound: Intel HD Audio Specification 1.0 Two channel sound

LVDS: support 24bits/2ch LVDS interface

WDT / DIO: Hardware watch dog timer support, 0~255 sec programmable
Hardware digital Input & Output, 8 x DI / 8 x DO

Touch screen: C8051F321 USB/COM interface touch screen controller,

support 4-, 5-, 8- wire Analog resistive touch screen (option)

Audio Amplifier: ANPEC APA4863 Class AB 2.2W Audio amplifier

Expansion interface: 1 x PCI Gold finger & 1 x PCle Mini card for PCle by one and
USB interface & 1 x PCle Mini card for PCle by one OR mSATA and USB interface
BIOS: AMI UEFI BIOS

Dimension: 200 x 150 mm

Power: On board DC-IN Convert into system power +12VAD/+5% to +5V/+5%
and +3.3V/+5%

Two 3G SIM card socket



1-3 Installing the CPU / PCH Heatsink. (Socket Version)

1. Install CPU bracket under the CPU first. 2.1. Locate Pinl in the socket,look for a
golden narrow.

2. Use screw driver and screw the socket 2.2. Lock the CPU socket by securing the
screw in anti-clockwise direction. screw in an anti-clockwise direction .

U -



3. Peel-off the Elastic Silicone sticker 3.2 Insert the system fan power cable to
under the Heat Sink. the pin header (FAN1) on board.

3.1 Tighten the HEAT SINK on the motherboard.
Pay attention to tighten the screws diagonally.

O
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1-4 Vertical SO-DIMM assembly guide

1. Install the memory into SODIMM. 2. Press down firmly to ensure the memory
is locked.

Uninstall

1. Pull open both sides of the memory slot. 2. Take out the memory.



1-5 Installing the CFast

1. Install the CFast card into the CFast socket.

10



1-6 Directions for installing the Mini Card

1. Unscrew the screw on the board 2. Plug in the Mini Card in a 45 angle

3. Gently push down the Mini Card and screw the screw back.

11



1-7 Packing List

Material Code [Description Detail Specification Quantit
1 | 7G1901-1261001-0 |MB-CI770A-6CXX-001 LF,CI770A-6CXX,Rev.:001 1
2 | 6G8006-2341-0100 |DVD LF,Intel Cedarview-D+ICH10R/NM10 1
3 | 6G7300-4526-0100 |Cooler LF,H=26.5mm,4.5Krpm,55W,CI770 1
4 | 6G5212-1203-0200 [120W Power Adapter,12V LF,M4p/Lock,FSP120-AHAN1,FSP 1
5 6G8001-2182-0400 [Manual LF,M/B,CI770A/C 1
6 6G6001-2005-0100 [COM FK LF,2.0 2*5P/DB9P,L=15cm 2
7 6G6001-2203-0100 [SATA DATA Cable (Red) LF,L=25cm 1
8 | 6G6003-1009-0100 |SATA Power Cable LF,L=25cm,1*5/2.0 to 180° SATA 15p 1

*The packing list above is for the users who purchase single motherboard. The users

who purchase the board with chassis may refer to the packing list in the Assembly Guide.

Please contact with your dealer if any of these items is missing or damaged
on delivery. And please keep all parts of the delivery package with packing
materials in case if you need to deliver or store the product in the future.

12



Chapter-2

Hardware Installation

2-1 Unpacking Precaution

This chapter provides the information how to install the hardware of CI1770A/C.
Please follow section 1-7, 2-1 and 2-2 to check the delivery package and unpack
carefully. Please follow the jumper setting procedure.

NOTE!

1. Do not touch the board or any other sensitive components without all necessary
anti-static protection.

2. Please pay attention to the voltage limitation of DC-IN12 V 5 %.
Overuse of DC-IN voltage limitation or change to another power adapter
(' not provided with this system ) will VOID warranty.

You should follow these

steps to protect the board from the static electric

discharge whenever you handle the board:

1. Ground yourself by a grounded wrist strap at all times when you
handle the CI770A/C.
Well secure the ALLIGATOR clip of the strap to the end of the shielded wire lead from
a grounded object. Please put on and connect the strap before handling the
CI770A/C for harmlessly discharge any static electricity
through the strap.

2. Please use anti-static pad to put any components, parts, or tools on the pad whenever
you work on them outside the computer. You may also use the anti-static bag instead of

the pad. Please ask your local supplier for necessary parts on anti-static requirement.

3. Do not plug any connector or set any jumper when the power is on.

13



2-2 Unpacking checkup

First of all, please follow all necessary steps of section 2-1 to protect CI770A/C
from electricity discharge. With reference to section 1-7

please check the delivery package again with following steps:

1. Unpack the CI770A/C board and keep all
packing material, manual and driver disc etc, do not dispose !

2. Is there any components lose or drops from the board?
DO NOT CONTINUE TO INSTALL THIS BOARD!
CONTACT THE DEALER YOU PURCHASED
THIS BOARD FROM, IMMEDIATELY.

3. Is there any visible damage on the board?
DO NOT CONTINUE TO INSTALL THIS BOARD!CONTACT
THE DEALER YOU PURCHASED THIS BOARD FROM, IMMEDIATELY.

4. Check your optional parts (i.e. DDR, CF etc.), all necessary jumpers
setting to jumper pin-set, and CMOS setup correctly.
Please also refer to all information of jumper settings in this manual.

5. Check your external devices (i.e. Add-On-Card, Driver Type etc.)
for complete add-in or connection and CMOS setup correctly.

Please also refer to all information of connector connection in this manual.

6. Please keep all necessary manual and driver disc in a good condition for future
re-installation if you change your Operating System.

14



2-3 Dimension-CI770A/C
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2-4 Layout-CI770A/C
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2-5 Diagram- CI770A/C
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2-6 Install Memory

This motherboard provides one 204-pin Small Outline Dual In-line Memory Module (SODIMM)
socket for memory expansion available maximum to of 2GB/4GB/8GB DDR3 SDRAM.

DDR3 clock supports: DDR3 1333/1600MT/S

Valid Memory Configurations

Total Memory
DIMM1/ 2 System Accept or Not
Max.
DS Accept 16GB
NOTE!

The detected memory size is less than actual installed memory size since
some memory has been allocated for system use.
That's how PC works with system memory.

Please refer to page 9 for installation of memory module.

18



2-7 List of Jumpers

JSB1: CMOS clear select

JSB2 : ME RTC clear select
JSC2,JSC21/22/23/24: COM2 RS232/422/485 select
JSP1: ATX / AT Power type select
JSD1: DPC Duty select

JVC1: COM1 voltage select

JVC2: COM2 voltage select

JVC3: COM3 voltage select

JVC4: COM4 voltage select

JVC5: COMS5 voltage select

JVC6: COM6 voltage select

JVL1: LVDS Panel power select

JVPL1: LVDS Panel Inverter power select
JVU14: USB14 voltage select

2-8 Jumper Setting Description

A jumper is ON as a closed circuit with a plastic cap covering two pins. A jumper is OFF
as an open circuit without the plastic cap. Some jumpers have three pins, labeled 1, 2,
and 3. You could connect either pin 1 and 2 or 2 and 3.The below figure 2.2 shows the

examples of different jumper settings in this manual.

Figure 2.2

All jumpers already have its default setting with the plastic cap inserted as ON,
or without the plastic cap as OFF. The default setting may be referred in this
manual with a " * " symbol .

___________________________________________________________________________|
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2-9 JSB1: CMOS Data Clear

A battery must be used to retain the motherboard configuration in CMOS RAM.
Close Pinl and pin 2 of JSBL1 to store the CMOS data.

To clear the CMOS,follow the procedures below:

1. Turn off the system and unplug teh AC power

2. Remove DC IN power cable from DC IN power connector

3. Locate JSB1 and close pin 1-2 for few seconds

4. Return to default setting

5. Connect DC IN power cable back to DC IN Power connector

JSBL | Description Note: Do not clear CMOS unless
*open | Normal set 1. Troubleshooting
short | CMOS data clear 2. Forget password
Note: Normal work is open jumper 3. You fail over-clocking system
JSB1
21 21

20



2-10 JSB2: ME RTC DATA Clear

A battery must be used to retain the motherboard configuration in ME RAM.
Close Pinl and pin 2 of JSB2 to store the ME data.

To clear the ME,follow the procedures below:

1. Turn off the system and unplug teh AC power
2. Remove DC IN power cable from DC IN power connector
3. Locate BAT1 and Remove Li battery
4. Locate JSB2 and close pin 1-2 for few seconds
5. Return to default setting
6. Install Li battery to BAT1 connector
7. Connect DC IN power cable back to DC IN Power connector
JSB2 | Description Note: Do not clear CMOS unless
*open | Normal set 1. Troubleshooting
short | CMOS data clear 2. Forget password
Note: Normal work is open jumper 3. You fail over-clocking system
JSB2
21 21

21



2-11 JSP1: AT/ATX Power select

JSP1 | Description
*1-2 | ATX power mode
2-3 | AT power mode

ATX power* AT power

2-12 JSC2,JSC21/22/23/24: COM2 RS232/422/RS485 select

JSC2 | JSC21 | JSC22 | JSC23 | JSC24 Description

*1-2 *1-2 *1-2 *1-2 *1-2 RS232*
3-4 2-3 2-3 2-3 2-3 RS422
5-6 2-3 2-3 2-3 2-3 RS485

ISC2  35c21 Jsc23
1[O0] 2 [Oalalo
*Rs232 3|0 0|4 [O|o]O|O
5|0 O|l6 |O|O|O|O

JSC22 JSC24

w N -

- O

ISC2 35c21 Jsc23

RS422 3|0 Ol4 |0O|O|O

ISC2 35c21 Jsc23

1[ool2 [Oo]olalo]:
RS485 3|0 0[4 [O|O]|O|0O|2
5|0 0|6 [O|O]O|O] 3

JSC22 JSC24

___________________________________________________________________________|
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2-13 COM port pin9 select RI signhal or Voltage source
JVC1: COM1 PIN9 select JVC2: COM2 PIN9 select
JVC3: COM3 PINO select ~ JVC4: COM4 PINO select
JVC5: COMS5 PIN9 select  JVC6: COM6 PIN9 select

JVC1/2/3/4/5/6 | Description

*1-2 COM port pin9 use RI signal
3-4 COM port pin9 use +5V voltage
5-6 COM port pin9 use +12V voltage

Note: 1. Note: Attention ! Check Device Power in spec
2. If want to use +5V/+12V need check system power design spec.

JVC6
————O0 O
1|00|2 1|00(2 1|{00|2
3|0 04 3|00|4 3|00|4
50 0J]6 5|/00|6 5[O0|6
*RI Signal +5V +12V
Jvcs Y
(Nimie)imie)imie} 1 O 2 1 2
3|0 0|0 0|00 3|0 000|004 3/00|00J|OCO|4
50 0|0 0|0 O 5 @) 6 5 Ol 6
JVC5 JVC4
*RI Signal +5V +12V
JvCi
1{O00|O00|2 100|002 1|O00|00|2
3|0 0|0 0|4 3|0 0|0 0|4 3/00|0 0|4
5|0 OO OJs 5000 0O|s 500|006
Jvec2
*RI Signal +5V +12V

23
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2-13 JVL1: LVDS panel power select

JVL1 | Description

1-2 |[+5V

*_3 [+3.3V

Note : Attention ! Check Device Power in spec.
JVL1 For eDP and LVDS panel power setting

JVL1
321 321
+5V *+3.3V

2-14 JVP1: LVDS panel Inverter power select

JVP1 [ Description

1-2 +12V

*2-3  [+5V

Note : Attention ! Check Device Power in spec.

JVP1
321 321
+5V *+3.3V




2-15JVU14: USB Port 14 Voltage select

JVU14 | Description

*1-2 | +3V

2.3 +3.3V

Note : Attention ! Check Device Power in spec.

Jvula
321 321

ey o
*+5Vv +3.3V

JDS1: DPC Duty set

2-16 JSD1: DPC Duty set

JSD1 |DESCRIPION

1-2 Low 0% (Low level)

*2.3 | Hi 100% (3.3V level)

Note : for Panel backlight dimming default active set
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Chapter-3

Connection
This chapter provides all necessary information of the peripheral's connections,
switches and indicators. Always power off the board before you install the peripherals.

3-1 List of Connectors

CA12: Mic-in (down side) / Line out (up side) phone jack.

CAS3: Line-out/Line-in/Mic-in 2x5 pin (2.0mm) wafer.

CAL1: Amplifier Line-out Left channel 2pin (2.0mm) wafer.

CARZ1: Amplifier Line-out Right channel 2pin (2.0mm) wafer.
SPDIF1: SPDIF audio output connector. (Option)

CC12: COM1 (up side)/COM2 (down side) dual DB9p connector.
CC11: COM1 2x5pin (2.0mm) wafer (The location share with CC12).
CC13: COM1 1x5pin (1.25mm) wafer.

CC2: COM2 DB9p connector (The location share with CC12).
CC21: COM2 2x5pin (2.0mm) wafer (The location share with CC12).
CC34: COM3 (up side)/COM4 (down side) dual DB9p connector.
CC31: COM3 2x5pin (2.0mm) wafer (The location share with CC34).
CC4: COM4 DB9p connector (The location share with CC34).
CC41: COM4 2x5pin (2.0mm) wafer (The location share with CC34).
CC5: COMS5 2x5pin (2.0mm) wafer.

CC6: COM6 2x5pin (2.0mm) wafer.

CC7: COM7 2x5pin (2.0mm) wafer.

CC8: COMB8 2x5pin (2.0mm) wafer.

CC9: COM9 2x5pin (2.0mm) wafer.

CC10: COM10 2x5pin (2.0mm) wafer.

CDG1: DVI-D (down side) / VGA (Up side) DB15p connector.

CG11: VGA port 2x5 pin (2.0mm) wafer.

HDMI1: HDMI type A connector.

LVDS1: LVDS 2x15 pin (1.25mm) connector.

CPP1: Panel inverter power connector 1x5 pin (2.0mm) wafer.

CT1: Touch screen device 2x5 pin (2.0mm) Wafer.

CIO1: DI port 0 ~ 3, DO port 0 ~ 3 2x5 pin (2.0mm) wafer.

CIO2: Dl port 4 ~ 7, DO port 4 ~ 7 2x5 pin (2.0mm) wafer.

CIO3: DI port 8 ~11, DO port 8 ~ 11 2x5 pin (2.0mm) wafer (option).
ClO4: DI port 12 ~15, DO port 12 ~ 15 2x5 pin (2.0mm) wafer (option).
CKM1: KB/MS port 1x6 pin (1.25mm) wafer connector.

___________________________________________________________________________|
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CO1: C 4pin (1.25mm) wafer

LPT1: LPT 2x13 pin (2.0mm) wafer (option).

CPI1: DC 12V-in DIN external connector (4pin mini din connector)

CPI11: DC 12V-in internal connector (2x2pin 4.2mm ATX connector) (option).
CPI13: DC-in 2x4 pin (2.0mm) wafer connector.

CPO1: DC +5/+12V output connector (2.5mm) wafer.

CPO2: DC +5/+12V output connector (2.5mm) wafer.

CPO3: DC +5/+12V output 1x4 pin(2.0mm) wafer (option).

CUS5: USB port 2 4pin(1.25mm) wafer (option).

CU6: USB port 3 4pin(1.25mm) wafer (option).

CU7: USB port 7 4pin(1.25mm) wafer.

CU8: USB port 8 4pin(1.25mm) wafer.

CU9: USB port 9 4pin(1.25mm) wafer. (The port share with touch device) (option).
CU10: USB port 10 4pin(1.25mm) wafer. (The port share with MPCE1) (option).
CU11: USB port 11 4pin(1.25mm) wafer. (The port share with MPCE2) (option).
CU12: USB port 12 4pin(1.25mm) wafer.

CU13: USB port 13 4pin(1.25mm) wafer.

CU14: USB port 14 4pin(1.25mm) wafer.

CUL1: USB port 3.0/2.0 3/4 and LAN1 RJ45 connector.

CUL2: USB port 3.0/2.0 1/2 and LAN2 RJ45 connector.

CFAL: CFast card socket 7+17pin (option).

SATAL: SATA port 1 (Gen Ill) connectors 7pin.

SATA2: SATA port 2 (Gen Ill) connectors 7pin.

SATA3: SATA port 3 connectors 7pin.

SATA4: SATA port 4 connectors 7pin.

MPCEL: Mini card port 1 sockets 52pin.

MPCEZ2: Mini card port 2 sockets 52pin.

SIM1: SIM port 1 card socket.

SIM2: SIM port 2 card socket.

CFP1: Front panel port 2x5 pin (2.54mm) wafer.

SWP1: Power On/Off switch wafer.

FAN1: CPU fan 1x3 pin (2.54mm) wafer.

FAN2: System fan 1x3 pin (2.54mm) wafer.

SODIM1/2: SO-DIM DDRS3 1.5V DRAM Socket
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[
3-2 DC 12V-IN external Connector

® CPI1: DC 12V-IN external Connector (4pin mini din connector)
PIN NO. | Description
1,2 +12V DC-IN
3,4 GND
Note: DC in from adapter plug in

® CPI11: DC 12V-IN Internal Connector (2x2pin 4.2mm ATX connector)
The location share with CPI1
PIN NO. | Description

34 +12V DC-IN

1,2 GND
Note: This connector share with CPI1 for OEM

® CPI13: DC 12V-IN Internal Connector (4pin 2.0mm wafer)

PIN NO. | Description PIN NO. | Description
1 +12V DC-IN 2 +12V DC-IN
3 +12V DC-IN 4 +12V DC-IN
5 NC 6 GND
7 GND 8 GND

Note: DC in from adapter plug in

cPi1L
Clly =412y
[ ')
179°
®ed ycrin
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3-3 DC +5/+12V Voltage output connector
e CPO1/CPO2: +12V/+5V DC voltage output (4pin 2.54mm Wafer)

PIN NO. | Description
1 +5V
2 GND
3 GND
4 +12V*

*Note: DC in +12V by switch to DC-out voltage +12V,
so DC in need stable +12V input

® CPO3: +12V/+5V DC voltage output (4pin 2.0mm Wafer)
The location share with CPO2

PIN NO. | Description
1 +5V
2 GND
3 GND
4 +12V*

*Note: 1. DC in +12V by switch to DC-out voltage +12V,
so DC in need stable +12V input
2. CPO3 connector share with CPO2 connector .

pinliil @ ® @

pinl
pinl| OO ®
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3-5 Front panel & FAN
® CFP1 Front panel connector (2 X 5 pin 2.54mm wafer)

PIN NO. | Description PIN NO. | Description
1 Power button pin 2 Power button GND
3 Reset pin 4 Reset GND
5 Power LED - 6 Power LED +
7 HDD LED- 8 HDD LED+
9 LAN LED- 10 LAN LED+

® SWP1 PB connector (2pin 2.0mm wafer)

PIN NO. | Description

1 Power button pin
2 Power button GND

FAN connectors
® FAN1: CPU FAN connector (3pin 2.5mm wafer)
® FAN2: System FAN connector (3pin 2.5mm wafer)

PIN NO. | Description
1 GND
2 +12V
3 FAN speed detect

Note: DC in +12V by switch to FAN power +12V,
so DC in need stable +12V input

pinl pinl

FAN2 E“El FAN1
O = [saes ]

10 CFP1 SWP1
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___________________________________________________________________________|
3-6 DVI-D / VGA

® CDG1: DVI 12bit connector down side (DB Connector)

PIN NO. | Description PIN NO. | Description PIN NO. | Description
1 Data 2- 9 Data 1- 17 Data O-
2 Data 2+ 10 Data 1+ 18 Data 0+
3 GND 11 GND 19 GND
4 NC 12 NC 20 NC
5 NC 13 NC 21 NC
6 l’C-CLK 14 | +5v 22 | GND
7 ’C-DATA 15 GND 23 CLK+
8 NC 16 DVI-DETECT 24 CLK-
® CDG1: VGA DB15 Connector Up side (D-SUB 15PIN)
PIN NO. | Description PIN NO. | Description PIN NO. | Description
1 RED 6 GND 11 NC
2 GREEN 7 GND 12 DDC DATA
3 BLUE 8 GND 13 H-SYNC
4 NC 9 NC 14 V-SYNC
5 GND 10 GND 15 DDC CLOCK
® CG11: VGA 2x5pin 2.0mm wafer connector
PIN NO. | Description PIN NO. | Description
1 BLUE 2 GND
3 GND 4 DDC CLOCK
5 GREEN 6 V-SYNC
7 GND 8 H-SYNC
9 RED 10 DDC DATA
*Note: VGA signal CG11 share with CDG1 VGA
VGA
I}VI—D
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[
3-7 HDMI interface

e HDMI1: HDMI Connector (Type A)

PIN NO. | Description | PIN NO. | Description PIN NO. | Description | PIN NO. | Description
1 TMDS2(p) 2 GND 3 TMDS2(n) 4 TMDS1(p)
5 GND 6 TMDS1(n) 7 TMDSO0(p) 8 GND
9 TMDSO(n) 10 TMDS CLK(p) 11 GND 12 TMDSCLK(n)
13 NC 14 NC 15 DDC CLK 16 DDC DATA
17 GND 18 +5V 19 HPD
HDMI

32



3-8 LVDS interface
® | VDS1: LVDS interface (2x15 pin 1.25mm wafer)

PIN NO. | Description PIN NO. | Description
1 PWM dimming 2 +5V
3 +LCD(5V or 3.3V) 4 +LCD(5V or 3.3V)
5 Channel-1-DATA3+ 6 Channel-0-DATA3+
7 Channel-1-DATA3- 8 Channel-0-DATA3-
9 Channel-0-DATA2+ 10 Channel-0-CLK+
11 Channel-0-DATA2- 12 Channel-0-CLK-
13 GND 14 GND
15 Channel-0-DATAL+ 16 Channel-0-DATAO+
17 Channel-0-DATA1- 18 Channel-0-DATAO-
19 GND 20 GND
21 +LCD(5V or 3.3V) 22 +LCD(5V or 3.3V)
23 Channel-1-DATA2+ 24 Channel-1-CLK+
25 Channel-1-DATA2- 26 Channel-1-CLK-
27 Channel-1-DATAL+ 28 Channel-1-DATAO+
29 Channel-1-DATAL- 30 Channel-1-DATAO-

Note: 1. LVDS interface support 18/24bits two channel
2. JVL1: LVDS panel +5V/+3.3V Voltage select

3. LVDS1 PIN 1 for panel backlight active, Default active setup by DPC Control
4. Pin 1 back light dimming control. Provided 200Hz / 275Hz / 380Hz / 20KHz / 25KHz

And adjust PWM duty cycle by software program
5. Mating connector: HIROSE DF13-30DS-1.25C or compatible
6. Cable housing: HIROSE DF13-30DP-1.25V or compatible

pinl
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LVDS1
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® CPP1: Panel Inverter power (5pin 2.0mm wafer)

PIN NO. | Description
1 +12V or +5V
2 GND
3 PWM dimming
4 ENBKL (3.3V)
5 ENBKL (5V)

Note: 1. JVP1 Inverter Voltage select
2. CPP1 PIN 3 and LVDS1 PIN1 is same signal.
Default active setup by JSD1
3. Pin 3 back light dimming control.
provided 200Hz / 275Hz / 380Hz / 20KHz /25KHz
and adjust PWM duty cycle by software program.

CPP1
oooon
A pinl
)
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e
3-9 Touch screen device

® CT1: Touch screen (2x5 pin 2.0mm wafer)
Default use USB interface, can change COM interface By OEM BOM.
® For 8- wire type pin define

PIN NO. | Description PIN NO. | Description
1 Bottom 2 Bottom Sense
3 Top Sense 4 Top
5 Right 6 Right Sense
7 Left 8 Left Sense
9 GND 10 KEY

Note: 1. For eight wire type cable Pin 3 and Pin4 need short.
2. Touch controller use USB port 9

® For 4- wire type pin define

PIN NO. | Description PIN NO. | Description
1 Bottom 2 N/A
3 N/A 4 Top
5 Right 6 N/A
7 Left 8 N/A
9 GND 10 KEY

Note: 1. For four wire type cable Pin 3 and Pin4 need short.
2. Touch controller use USB port 9

® [For 5- wire type pin define

PIN NO. | Description PIN NO. | Description
1 UR(H) 2 N/A
3 Sense 4 UL(Y)
5 LR(X) 6 N/A
7 LL(L) 8 N/A
9 GND 10 KEY

Note:1. Touch controller use USB port 9

CTL 10
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|
3-10 Audio interface
® CA12: Up side Line out (3.5mm phone jack)

PIN NO. 1 2 3
GND | Line OUT-L NC

4 5
NC | Line OUT-R

Description

® CA12: Down side Mic in (3.5mm phone jack)
PIN NO. 1 2 3 4 5
GND Mic-IN NC NC Mic-IN

Description

® CA3: Line-out/Line-in/Mic-in 2x4 pin (2.0mm) Header

PIN NO. Description PIN NO. Description
1 Line-out-R 2 MIC-IN
3 Line-in-R 4 GND
5 GND 6 GND
7 Line-in-L 8 NC
9 Line-out-L 10 MIC-IN

CA1l12

® Audio Amplifier class AB Two channel 2W/ch pint

® CAR1: Audio Amplifier Line Out Right
(2pin 2.0mm wafer)

PIN NO. | Description
1 LINE-OUT_R+
2 LINE-OUT_R-

10 CA3

® CAL1: Audio Amplifier Line Out Left

(2pin 2.0mm wafer)
PIN NO.

Description
LINE-OUT_L+
2 LINE-OUT_L-

®SPDIF Digital Photo out connector
®SPDIF1: SPDIF audio output connector.

PIN NO. 1 2 3
Description | GND +5V [ Audio DATA
Note: Share CA12 location , by OEM

v pinl
CAR1 @

CAL1 @Pinl
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3-11 COM ports

® COM2 default support RS232/RS422/RS485 mode
COM1/3/4/5/6 default support RS232 mode

® RS232 Mode connector (D-SUB 9pin)
CC12: COML1 (up side) / COM2 (down side) port connector
CC34: COM3 (up side) / COM4 (down side) port connector
CC2: COM2 Single port connector. (The location share with CC12)
CC4: COM4 Single port connector. (The location share with CC34)

PIN NO. | Description PIN NO. | Description
1 DCD 6 DSR
2 RXD 7 RTS
3 TXD 8 CTS
4 DTR 9 RI/VOLTAGE
5 GND

Note: 1. Pin 9 Rl and Voltage setting only for COM 1/2/3/4/5/6 ports
JVC1 for COM1,JVC2 for COM2 , JVC3 for COM3,JVC4 for COM4
2. COM2 default support RS232/RS422/RS485 by JSC2/21/22/23/24 selected.

® RS485 Mode conector (D-SUB 9pin)
CC12: COM1 (up side) / COM2 (down side) port connector
CC34: COM3 (up side) / COM4 (down side) port connector
CC2: COM2 Single port connector. (The location share with CC12)
CC4: COM4 Single port connector. (The location share with CC34)

PIN NO. | Description PIN NO. | Description
1 RS485 TX- 6 NC
2 RS485 TX+ 7 NC
3 NC 8 NC
4 NC 9 Rl / VOLTAGE
5 GND

Note: 1. COM2 default support RS232/RS422/RS485 by JSC2/21/22/23/24 selected.
2. COM1/3/4/5/6 Default RS232 , RS485 / 422 by OEM bom

COM3 COM1

bt
'y

COM4 COM2
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® RS422 Mode conector (D-SUB 9pin)
CC12: COM1(up side)/COM2 (down side) port connector
CC34: COM3 (up side) / COM4 (down side) port connector
CC2: COM2 Single port connector. (The location share with CC12)
CC4: COM4 Single port connector. (The location share with CC34)

PIN NO. | Description PIN NO. | Description
1 RS422 TX- 6 NC
2 RS422 TX+ 7 NC
3 RS422 RX+ 8 NC
4 RS422 RX- 9 RI/VOLTAGE
5 GND

Note: 1. COM2 default support RS232/RS422/RS485 by JSC2/21/22/23/24 selected.
2. COM1/3/4/5/6 Default RS232 , RS485 / 422 by OEM bom
® RS232 mode ports (2 X 5 pin 2.0mm wafer)
CCl11: COM1 CC21: COM2
CC31: COM3 CC41: COM4

CC5:COM5 CC6: COMG6
PIN NO. | Description PIN NO. | Description
1 DCD 2 RXD 10
3 TXD 4 DTR
5 GND 6 DSR cco pinl
7 RTS 8 CTS
9 RI/ Voltage 10 NC 10

Note: 1. CC11, CC21 share with CC12 connector for OEM ccs
2. CC31, CC41 share with CC34 connector for OEM pinl
3. The Pin 9 Voltage set by JVC1/2/3/4/5/6

® RS485 ports (2x5pin 2.0mm Wafer)
CC11: COM1 CC21: COM2
CC31: COM3 CC41: COM4

CC5:COM5 CC6: COM®6

PIN NO. | Description PIN NO. | Description
1 RS485 TX- 2 RS485 TX+
3 NC 4 NC
5 GND 6 NC
7 NC 8 NC
9 RI/ Voltage 10 NC

Note: 1. CC11, CC21 share with CC12 connector for OEM

2. CC31, CCA41 share with CC34 connector for OEM

3. The Pin 9 Voltage set by JVC1/2/3/4/5/6
|
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® RS422 mode ports (2 X 5 pin 2.0mm wafer)
CC1l1l: COM1 CC21: COM2
CC31: COM3 CC41: COM4

CC5:COM5 CC6: COM®6

PIN NO. | Description PIN NO. | Description
1 RS422 TX- 2 RS422 TX+
3 RS422 RX+ 4 RS422 RX-
5 GND 6 NC
7 NC 8 NC
9 RI / Voltage 10 NC

Note: 1. CC11, CC21 share with CC12 connector for OEM
2. CC31, CC41 share with CC34 connector for OEM
3. The Pin 9 Voltage set by JVC1/2/3/4/5/6

® CC13: COM1 RS232 port (5pin 1.25mm Wafer)

PIN NO.

1

2 3

4 5

Description

+5V

GND

RTS

TXD

RXD

Note: All signals are RS232 level.

® COM ports from (PLX OXPCle954)
COM?7/8/9/10 default support RS232 mode
COM7/8/9/10 is option for OEM.

® RS232 ports (2x5pin 2.0mm Wafer)
COM ports from (PLX OXPCle954)

CC7: COM7 CC8: COMS8
CC9: COM9 CC10: COM10
PIN NO. | Description PIN NO. | Description
1 DCD 2 RXD
3 TXD 4 DTR
5 GND 6 DSR
7 RTS 8 CTS
9 RI / Voltage 10 +5V

® RS485 ports (2x5pin

2.0mm Wafer)

CC7:COM7 CC8: COMS8

CC9: COM9 CC1l0: COM10

PIN NO. | Description PIN NO. | Description
1 RS485 TX- 2 RS485 TX+
3 NC 4 NC
5 GND 6 NC
7 NC 8 NC
9 Rl / Voltage 10 +5V
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3-12 Digital Input / Output
oC|O1 DIO 0 ~ 3 (2x5pin 2.0mm wafer)

PIN NO. | Description [ PIN NO. | Description
1 DI-0 2 DO-3
3 DI-1 4 DO-2
5 DI-2 6 DO-1
7 DI-3 8 DO-0
9 GND 10 +5V

Note: 1. The system default 8DI and 8DO
2. DI pin default pull up 10KQ to +5V
3. If use need isolate circuit to control external device
4. F75111N-1 I°C bus address 0x9c

® ClO2 DIO 4 ~ 7 (2x5pin 2.0mm wafer)

PIN NO. | Description PIN NO. | Description
1 DI-4 2 DO-7
3 DI-5 4 DO-6
5 DI-6 6 DO-5
7 DI-7 8 DO-4
9 GND 10 +5V

Note: 1. The system default 8Dl and 8DO
2. DI pin default pull up 10KQ to +5V
3. If use need isolate circuit to control external device ClO2 CIo4

4. F75111N-1 I’C bus address 0x9c om|em|pinl
(N NI N ]
© CIO3 DIO 8 ~ 11 (2x5pin 2.0mm wafer) (option) selles
PIN NO. | Description | PIN NO. | Description 0jee oo
om|om|pinl
! D8 2 po-11 eooe
(N NI N ]
3 DI-9 4 DO-10 e
5 DI-10 6 DO-9 w|jeelee
7 DI-11 8 DO-8 ClO1 CIOo3
9 GND 10 +5V

Note: 1. CIO3 is option function
2. DI pin default pull up 10KQ to +5V
3. If use need isolate circuit to control external device
4. F75111N-2 I’C bus address 0x6e
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® CIO4 DIO 12 ~ 15 (2x5pin 2.0mm wafer) (option)

PIN NO. | Description PIN NO. | Description
1 DI-12 2 DO-15
3 DI-13 4 DO-14
5 DI-14 6 DO-13
7 DI-15 8 DO-12
9 GND 10 +5V

Note: 1. ClO4 is option function
2. DI pin default pull up 10KQ to +5V
3. If use need isolate circuit to control external device
4. F75111N-2 I°C bus address 0x6e

® For F75111N I°C watch dog timer device:
DC spec:
Input low Voltage (VIL)\+0.8 Max
Input High Voltage (VIH): +2V Min
Output low Current (IOL): 10mA (Min) VOL=0.4V
Output High Current (IOH): -10mA (Min) VOH=2.4V
Watch Dog Time value 0~255 sec
The system will be issued reset. When WDT is enable the hardware start down counter
to zero. The reset timer have 10~20% tolerance upon the Temperature.
Note: If want to SDK support. Please contact to sales window.

Please refer to page 92 for APPENDIX C: F75111N I°C DIO DECICE
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e
3-13 I)C Bus Interface

e CO1: I°C (SM) bus connector (4 pin 1.25mm wafer)
PIN NO. 1 2 3 4
Description +3.3V GND SMB_CLK | SMB_DATA

COo1

o > [eeen]om

3-14 PS2 KB/MS
® CKM1: KB/MS port (1 X 6 pin 1.25mm wafer)
PIN NO. 1 2 3 4 5 6
Description +5V KB/DAT KB/CLK GND MS/DAT MS/CLK

pinl

O - [meeece]im
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3-15 LAN+USB Connrctor
® CUL1/CUL2 (Down side): USB3.0/2.0 Type A jack

PIN NO. | Description PIN NO. | Description
1 USB3.0 TX+
1 +5V
2 USB 2.0 D- USB3.0 TX-
GND
3 USB 2.0 D+ 4 USB3.0 RX+
4 GND

Note: 1. USB 3.0 and USB 2.0 combo Type A Jack
2.CUL1 USB 3.0 port 3 and 4 , USB2.0 port 5 and 4
3.CUL2 USB3.0 port 1 and 2, USB2.0 port 1 and 2

4.USB3.0/2.0 Keyboard and Mouse use CUL1 can pitch Some OS install

And wake up Keyboard and Mouse can’t work issue
® CUL1/CUL2 (Down side): USB3.0/2.0 Type A jack

PIN NO. | Description PIN NO. | Description
1 TDO-/TX+ 5 TD2-INC
2 TDO+/TX- 6 TD2+/RX-
3 TD1-/RX+ 7 TD3-/INC
4 TD1+/NC 8 TD3+/NC

Back side con | RED LED GREEN LED YELLOW LED
Indicate GIGA LAN 100Mb LAN Active LED
Link(light) Link(light) Link(Blink)

® RJ45 LAN Connector--- LED define Giga/100MB Connector

® RJ45 LAN Connector--- LED define Giga/100/10MB Connector

?
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SPEED 10 Mbps 100Mbps 1000 Mbps
Side Back Front Back Front Back Front
Indicate
LED Link ACT ACT Link ACT ACT Link ACT ACT
LAN Light Orange | Orange | Green | Orange | Orange| Red |Orange |Orange
CUL2 cCuL1




3-16 USB Interface

® CU5/6/7/8/9/10/11/12/13:

USB5/6/7/8/9/10/11/12/13 port (4pin 1.25mm Wafer)

PIN NO. Description
1 +5V
2 USB DATA -
3 USB DATA +
4 GND

Note: 1. CU5 and CU6 no connector

2. The CU10 share with MPCEL (no connector).

3. The CU11 share with MPCE2 (no connector).

4. The CU9 share with touch device (no connector).
5. CU10,CU11 pin can support +12V by OEM

® CU14: USB14 port (4pin 1.25mm Wafer)

PIN NO. Description
1 +5V or +3.3V
2 USB DATA -
3 USB DATA +
4 GND

Note: 1.PIN 1 Voltage select from JSU14

Cu9
Cul1o
Ccu1l

pinl pinl

CU5|ooo-| eeem |CUG

CU?I....| eoon cus

pinl pinl

oooOm (000N (12

eoem o0oenm|CUI3

eeoem o0oenm|CUl4
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3-17 SATA interface

® SATAL, SATA2: The two SATA connectors (7pin wafer)
SATA3, SATA4: The two SATA connectors (7pin wafer)
PIN NO. Description
GND
DATA TX+
DATA TX-
GND
DATA RX-
DATA RX+
GND

N[fojloa|lb~|lWIN|F

Note: 1. SATAL and SATA2 support SATA 3.0 spec update 6Gb/sec .
2. SATA3 and SATA4 support SATA 2.0 spec update 3Gb/sec .
3. COP1 and COP2 provide SATA HDD power +12V,GND ,+5V

SATA4
SATA3 [0 Pss®ss*10] [0 Pss®ss*10)]

pinl pinl <—©
SATAL [§ tss®ss*10][0 tss®ss*10]

pinl pinl SATA2
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3-18 Mini card
® MPCE1/MPCEZ2: Support USB and PCle by one Interface
(Mini card socket 52pin)

PIN NO. Description PIN NO. Description
1 NC 2 +3.3V
3 NC 4 GND
5 NC 6 +1.5V
7 NC 8 SIM Power
9 GND 10 SIM Data
11 PCle-CLK- 12 SIM CLK
13 PCle-CLK+ 14 SIM Reset
15 GND 16 SIM RFU
KEY KEY KEY KEY
17 NC 18 GND
19 NC 20 NC
21 GND 22 RST-
23 PCle-RX-/mSATA-RX+ 24 +3.3V
25 PCle-RX+/mSATA-RX- 26 GND pins2 pins2
] e
31 PCle-TX-/mSATA-TX- 32 SMB-DATA pinl pinl
33 PCle-TX+/mSATA-TX+ 34 GND MPCE2 MPCE1
35 GND 36 USB-DATA-
37 GND 38 USB-DATA+
39 +3.3V 40 GND
41 +3.3V 42 NC
43 GND 44 NC
45 NC 46 NC
47 NC 48 +1.5V
49 NC 50 GND
51 MSATA-Detect 52 +3.3V

Note: 1. MPCE 1 used USB port 10, MPCE2 used USB port 11.

2. MPCEL1 Pin 8, 10,12,14,16 for SIM1 card reader use.

3. MPCEZ2 Pin 8, 10,12,14,16 for SIM2 card reader use.

4. Just only MPCEL pin23, 25, 31, 33 supported mSATA device and
PCle device alternatively.

5. Pin51 mSATA / PCle auto detect function

6. MSATA use system SATA port 6 , the port share with on board NANADrive
This port only choice one device can't work at same time.
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3-19 SIM Socket

® SIM1,SIM2: SIM card socket pin define is follow ISO 7816-2 smart card

PIN NO. | Description PIN NO. | Description
1 Vce 1 GND
2 RST 2 Vpp
3 CLK 3 DATA
4 RUF 4 RUF

Note: 1. MPCEL1 Pin 8, 10,12,14,16 for SIM1 card reader use.
2. MPCEZ2 Pin 8, 10,12,14,16 for SIM2 card reader use.

3-20 SODIMM socket
® SODIM1/2: SO-DIM DDR3 1.5V DRAM Socket

‘ SODIMM1

IRLLLLU WL
° 9.2 W L4

[ THRTRTIRTTIRTTRTTOR TR DNTORAIORIY AT |

° 9.2, .
R 111111111111 O
SODIMM2
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3-21 LPT interface (Line Print Terminal)
® | PT1: LPT 2x13 pin (2.0mm)wafe header

PIN NO. | Description PIN NO. [ Description
1 STROBE# 2 AUTO FROM FEED#
3 DATAO 4 ERROR#
5 DATA1 6 INITIALIZE
7 DATA2 8 PRINTER SELECT LN#
9 DATA3 10 GND
11 DATA4 12 GND
13 DATAS 14 GND
15 DATAG6 16 GND
17 DATA7 18 GND
19 ACKNOWLEDGE 20 GND
21 BUSY 22 GND
23 PARER EMPTY 24 NC
25 PRINTER SELECT 26 NC

Note: BOM default haven't this function by OEM

®e |26
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3-22 CFast card Reader and SATA

® CFAL: CFA Socket For SATA Interface (24pin CFA Socket)
PIN NO. | Description

S1 GND
S2 SATATX+
S3 SATA TX-
S4 GND

S5 SATA RX-
S6 SATA RX+

S7 GND

PC1 |GND(Card Detect In)
PC2 GND

PC3 NC

PC4 NC

PC5 NC

PC6 |NC

PC7 GND

PC8 |NC(LED Out)

PC9 | NC(LED Out)

PC10 |NC

PC11 |NC

PC12 |NC

PC13 |+3.3V

PC14 |+3.3V

PC15 |GND CFAl
PC16 |GND

PC17 | GND(Card Detect In)

Note: CFAL use SATA port 5
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3-23 PCI Gold Finger PIN Define

PIN NO. PIN NO.
A1 [NC Bl |NC
A2 |+12v B2 |NC
A3 |+5V B3 |GND
A4 |45V B4 |NC
A5 |+5v B5 |+5V
A6 |[NC B6 |+5V
A7 |NC B7 |NC
A8 |+5v B8 |NC
A9 |BUF _PLT RST# B9 |CLK_PCIE_AP
AL10 |+5V B10 |CLK_PCIE_AN
A1l |PCIE_RXP_A B1l |PCIE_RXN_A
A12 |GND B12 |PCIE_TXN_A
A13 |GND B13 |PCIE_TXP_A
Al4  |+3.3V Bl4 |PCIE_WAKE#
A15 |NC B15 |GND
A16 |+5V B16 |NC
A17 |NC B17 |GND
A18 |GND B18 [NC
A19 |P_PME# B19 |+5v
A20 |NC B20 [NC
A21 |+3.3V B21 [NC
A22 |CLK_PCIE_BP B22 |GND
A23 | CLK_PCIE_BN B23 |PCIE_TXN_B
A24 |GND B24 |PCIE_TXP_B
A25 |NC B25 | +3.3V
A26 |NC B26 |NC
A27 |+3.3v B27 |NC
A28 |PCIE_RXP_B B28 |GND
A29 |PCIE_RXN_B B29 |PCIE_TXP_C
A30 |GND B30 |PCIE_TXN_C
A31 |PCIE_RXP_C B3l [+3.3V
A32 |PCIE_RXN_C B32 |[NC
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PIN NO. PIN NO.
A33 | STROBE# B33 NC
A34 |NC B34 GND
A35 |GND B35 NC
A36 |NC B36 +3.3V
A37 |GND B37 NC
A38 |NC B38 GND
A39 |+3.3V B39 NC
A40 | DATA6 B40 NC
A4l DATA7 B41 +3.3V
A42 |GND B42 NC
A43  |NC B43 +3.3V
A44  |NC B44 CLK_PCIE_CP
A45 | +3.3V B45 CLK_PCIE_CN
A46 | PCIE_RXP_D B46 GND
A47 PCIE_RXN_D B47 NC
A48 |GND B48 NC
A49 NC B49 GND
A52 NC B52 PCIE_TXP_D
A53 | +3.3V B53 PCIE_TXN_D
A54 | CLK_PCIE_DP B54 +3.3V
A55 | CLK_PCIE_DN B55 NC
A56 |GND B56 NC
A57 NC B57 GND
A58 |NC B58 NC
A59 | +5V B59 +5V
A60 +5V B60 +5V
AB1 | +5V B61 +5V
A62 +5V B62 +5V
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Chapter-4

Introduction of BIOS

The BIOS is a program located in the Flash Memory on the motherboard.

This program is a bridge between motherboard and operating system.

When you start the computer, the BIOS program gains control.

The BIOS first operates an auto-diagnostic test called POST

(Power on Self Test) for all the necessary hardware, it detects the entire hardware

devices and configures the parameters of the hardware synchronization. After these tasks
are completed, BIOS will give control of the computer back to operating system (OS).
Since the BIOS is the only channel for hardware and software to communicate with, it is
the key factor of system stability and of ensuring your system performance at best.

In the BIOS Setup main menu, you can see several options. We will explain these options
in the following pages. First, let us see the function keys you may use here:

Press <Esc> to quit the BIOS Setup.

Press 1|«<—(up, down, left, right) to choose the option you want to confirm or modify.
Press <F10> to save these parameters and to exit the BIOS Setup menu

after you complete the setup of BIOS parameters.

Press Page Up/Page Down or +/- keys to modify the BIOS parameters for

the active option.

4-1 Enter Setup

Power on the computer and press <Del> key immediately to enter Setup.

If the message disappears before your respond but you still wish to enter Setup,
restart the system by turning it OFF then ON or You may also restart the system by
simultaneously pressing <Ctrl>, <Alt> and <Delete> keys.
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4-2 BIOS Menu Screen

The following diagram show a general BIOS menu screen

Main Advanced Chipset Boot Security Save & Exit —> Menu Bar
BIOS Vendor CI770C/A Set the date. Use Tab
Processor Information to Switch between
date elements.
Name IvyBridge
Brand String Intel(R) Core(TM) i7
Frequency 2300 MHz \l/
General Help Items
Total Memory 2048 MB (DDR3)
Memory Frequency 1333 MHz
—«: Select Screen
11: Select Item
Enter: Select
System Date [Tue 01/15/2013] +/-: Change Opt.
System Time [19:28:51] F1: General Help
F2: Previous Values
\l/ . F3: Optimized Defaults
Menu ltems Current Setting Value F4: Save & Exit
Function Keys &4 Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

4-3 Function Keys

In the above BIOS Setup main menu of, you can see several options.

We will explain these options step by step in the following pages of this chapter,

but let us first see a short description of the function keys you may use here:

@ Press —— (left, right) to select screen;

@ Press 1| (up, down) to choose, in the main menu, the option you want to confirm or to modify.
@ Press <Enter> to select.

@ Press <+>/<—> keys when you want to modify the BIOS parameters for the active option.
@ [F1]: General help.

@ [F2]: Previous value.

@ [F3]: Optimized defaults.

@ [F4]: Save & Reset.

@ Press <Esc> to quit the BIOS Setup.
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4-4 Getting Help

Main Menu
The on-line description of the highlighted setup function is displayed at the top right corner
the screen.

Status Page Setup Menu/Option Page Setup Menu
Press F1 to pop up a small help window that describes the appropriate keys to use and
the possible selections for the highlighted item. To exit the Help Window, press <Esc>.

4-5 Menu Bars

There are six menu bars on top of BIOS screen:

Main To change system basic configuration
Advanced To change system advanced configuration
Chipset To change chipset configuration

Boot To change boot settings

Security Password settings

Save & Exit  Save setting, loading and exit options.
User can press the right or left arrow key on the keyboard to switch from menu bar.
The selected one is highlighted.

4-6 Main
Main Advanced Chipset Boot Security Save & Exit
BIOS Vendor CI770C/IA Set the date. Use Tab
to Switch between
date elements.
Processor Information
Name IvyBridge
Brand String Intel(R) Core(TM) i7 e Select Screen
Frequency 2300 MHz 11: Select Item
Total Memory 2048 MB (DDR3) Enter: Select
Memory Frequency 1333 MHz +/-: Change Opt.
F1: General Help
F2: Previous Values
System Date [Tue 01/15/2013] F3: Optimized Defaults
System Time [19:28:51] F4: Save & Exit
Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.
Main menu screen includes some basic system information. Highlight the item and then use
the <+> or <-> and numerical keyboard keys to select the value you want in each item.

System Date
Set the Date. Please use [Tab] to switch between data elements.
System Time
Set the Time. Please use [Tab] to switch between data elements.

___________________________________________________________________________|
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4-7 Advanced

Main Advanced Chipset Boot Security Save & Exit
» ACPI Settings System ACPI
» S5 RTC Wake Setting Parameters.
» CPU Configuration
» SATA Configuration
» USB Configuration e Select Screen
» SMART Setting 11: Select Item
»F71869 Super IO Configuration Enter: Select
»F71869 H/W Monitor +/-: Change Opt.
»F81216 Second Super 10 Configuration F1: General Help
» Serial Port Console Redirection F2: Previous Values
» Network Stack F3: Optimized Defaults
F4: Save & Exit
Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

ACPI Settings
Please refer section 4-7-1

S5 RTC Wake Setting
Please refer section 4-7-2

CPU Configuration
Please refer section 4-7-3

SATA Configuration
Please refer section 4-7-4

USB Computing
Please refer section 4-7-5

SMART Settings
Please refer section 4-7-6

F71869 Super IO Configuration
Please refer section 4-7-7

F71869 H/W Monitor
Please refer section 4-7-8

F81216 Second Super IO Configuration
Please refer section 4-7-9

Serial Port Console Redirection
Please refer section 4-7-10

Network Stack

Please refer section 4-7-11

___________________________________________________________________________|
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4-7-1 ACPI Settings

Main Advanced Chipset Boot Security Save & Exit

ACPI Settings Enables or Disables
BIOS ACPI Auto

Enable ACPI AUTO Configuration [Disabled] Configuration.

Enable Hibernation [Enabled] s« Select Screen

ACPI Sleep State [S1 only(CPU Stop C..)] 11: Select Item

Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Enable ACPI Auto Configuration
This item allows you to Enabled/Disabled the Advanced Configuration and Power
Management (ACPI).

Enable Hibernation
This item allows you to Enabled/Disabled the Hibernate feature.

ACPI Sleep State

Select ACPI sleep state the system will enter when the SUSPEND button is pressed.

The optional settings: Suspend Disabled / S1 only(CPU Stop Clock) / S3 only(Suspend to RAM) /
Both S1 and S3 available for OS choose from.
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4-7-2 S5 RTC Wake Settings

Main Advanced Chipset Boot Security Save & Exit
Wake system with Fixed Time [Disabled] Enable or disable
Wake system with Dynamic Time [Disabled] System wake on alarm

event when enabled.
System will wake on the
hr : min : sec specified

—«—: Select Screen
11: Select Item

Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.
Wake system with Fixed Time
Use this item to Enable or Disable system wake on alarm event. When set as Enabled,
system will wake on the hour/min/sec specified.
Wake system with Dynamic Time
Use this item to Enable or Disable system wake on alarm event. When set as Enabled,
system will wake on the current time + Increase minute(s).
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4-7-3 CPU Configuration

Main Advanced Chipset Boot Security Save & Exit
CPU Configuration Number of cores to
enable in each
Intel(R) Core(TM) i7-3610QE CPU @ 2.30GHz processor package.
CPU Signature 306a9
Microcode Path 10
Max CPU Speed 2300 MHz
Min CPU Speed 1200 MHZ
CPU Speed 2300 MHZ
Processor Cores 4
Intel HT Technology Supported
Intel VT-x Technology Supported
Intel SMX Technology Supported
64-bit Supported
L1 Data Cache 32KB x4 — Select Screen
L1 Code Cache 32 KB x 4 11: Select Item
L2 Cache 256 KB x 4 Enter: Select
L3 Cache 6144 KB +/-: Change Opt.
F1: General Help

Hyper-threading [Enabled] F2: Previous Values
Active Processor Cores [All] F3: Optimized _Defaults
Execute Disable Bit [Enabled] E:ciil\t/e & Bxit
Intel Virtualization Technology [Disabled]

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Hyper-threading

Use this item to Enabled for Windows XP and Linux (OS optimized for Hyper-Threading Technology)
and Disabled for other OS (OS not optimized for Hyper-Threading Technology).

When Disabled only one thread per enabled core is enabled.

Active Processor Cores
Use this item to select number of cores to enable in each processor package.

Execute Disable Bit

XD can prevent certain classes of malicious buffer overflow attacks when combined with a supporting
OS (Windows Server 2003 SP1, Windows XP SP2, SuSE Linux 9.2, RedHat Enterprise 3 Update 3.)
The optional settings are: Disabled, Enabled.

Intel Virtualization Technology

When set as Enabled, a VHM can utilize the additional hardware capabilities provided
by Vanderpool Technology.

The optional settings: Enabled, Disabled.

___________________________________________________________________________|
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4-7-4 SATA Configuration

Main Advanced Chipset Boot Security Save & Exit
SATA Controller(s) [Enabled] Enable or disable SATA
SATA Mode Selection [IDE] Device.

—«: Select Screen
11: Select Item

Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.
SATA Controller(s)
Use this item to Enable or Disable SATA Device.
SATA Mode Selection
Determine how SATA controller(s) operate.
The optional settings are: IDE Mode, AHCI Mode.

4-7-4-1 SATA Mode Selection - AHCI Mode

Main Advanced Chipset Boot Security Save & Exit
SATA Controller(s) [Enabled] Enable or disable SATA
SATA Mode Selection [AHCI] Device.
SATA Controller Speed [Gen3]

» Software Feature Mask Configuration

—«: Select Screen
11: Select Item

Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

SATA Controller Speed

Indicates the maximum speed the SATA controller can support.
The optional settings: Genl, Gen2, Gen3.

Software Feature Mask Configuration

Please refer section 4-7-4-1-1
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4-7-4-1-1 » Software Feature Mask Configuration

Main Advanced Chipset Boot Security Save & Exit

RAIDO [Enabled] Enable or disable RAIDO
RAID1 [Enabled] feature.

RAID10 [Enabled]

RAID5 [Enabled]

—«—: Select Screen
11: Select Item

Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

RAIDO,RAID1,RAID10,RAID5
Enable or disable RAIDO, RAID1, RAID10, RAIDS feature.
The optional settings: Enabled, Disabled.

4-7-4-2 SATA Mode Selection - RAID Mode

Main Advanced Chipset Boot Security Save & Exit

SATA Controller(s) [Enabled] Enable or disable SATA
SATA Mode Selection [RAID] Device.

SATA Controller Speed [Gen3]

—«: Select Screen
1]: Select Item
Alternate ID [Disabled] Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

» Software Feature Mask Configuration

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.
SATA Controller(s)
SATA Mode Selection
SATA Controller Speed
» Software Feature Mask Configuration

Please refer section 4-7-4-1-1

Alternate ID
Report alternate Device ID
The optional settings: Enabled, Disabled.
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4-7-5 USB Configuration

Main Advanced Chipset Boot Security Save & Exit

USB Configuration Enables Legacy USB
support. AUTO option

USB Devices: disables legacy support

if no USB devices are
connected. Disable
option will keep USB

1 Keyboard, 2 Mice, 2 Hubs

Legacy USB Support [Enabled] devices available only
USB3.0 Support [Enabled] for EFI applications.
XHCI Hand-off [Enabled]

—«: Select Screen
11: Select ltem

Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

EHCI Hand-off [Disabled]

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Legacy USB Support

Enables Legacy USB support. AUTO option disables legacy support if no USB devices are
connected. Disable option will keep USB devices available only for EFI applications.
USB3.0 Support

Use this item to turn on/off USB3.0 Controller support.

The optional settings are: Enabled, Disabled.

XHCI Hand-off

This is a workaround for OSes without XHCI handoff support.

The XHCI ownership change should be claimed by XHCI driver.

The optional settings are: Enabled, Disabled..

EHCI Hand-off

This is a workaround for OSes without EHCI handoff support.
The EHCI ownership change should be claimed by EHCI driver.
The optional settings are: Enabled, Disabled.
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4-7-6 SMART Settings

Main Advanced Chipset Boot Security Save & Exit

Smart Settings Run SMART Self Test on
all HDDs during POST.

Smart Self Test [Disabled]

—«: Select Screen
11: Select ltem

Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

SMART Self Test
Run Smart Self Test on all HDDs during POST.
The optional settings are: Disabled, Enabled.

4-7-7 F71869 Super 10 Configuration

Main Advanced Chipset Boot Security Save & Exit
F71869 Super 10 Configuration Set Parameters of Serial
Port 0(COMA)
F71869 Super 10 Chip F71869
» Serial Port 1 Configuration —«—: Select Screen
» Serial Port 2 Configuration 11: Select Item
Power Failure [Keep last state] Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Serial Port 1 Configuration
Please refer section 4-7-7-1

Serial Port 2 Configuration
Please refer section 4-7-7-1

Power Failure

This item specifies whether your system will reboot after a power failure or interrupt occurs.

[Keep last state]  Restores the system to the status before power failure or interrupt occurred.
[Bypass mode] Restores the system to the bypass mode.

[Always on] Leaves the computer in the power on state.

[Always off] Leaves the computer in the power off state.
|
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4-7-7-1 » Serial Port 1 Configuration & Serial Port 2 Configuration

Main Advanced Chipset Boot Security Save & Exit

Serial Port 1~2 Configuration Enable or Disable Serial
Port (COM)

Serial Port [Enabled]

Device Settings 10=3F8h; IRQ=4; —«: Select Screen
1]: Select ltem

Change Settings [AUTO] Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

COM1 422/485 control flow [Disabled]
COM2 422/485 control flow [Disabled]

Serial Port
Use this item to enable or disable serial port (COM).
The optional settings are: Enabled, Disabled.

Change Settings

Use this item to select an optimal setting for super 10 device.
The optional settings are:

AUTO

10=3F8h; IRQ=4;

10=3F8h; IRQ=3,4,5,6,7,10,11,12;

10=2F8h; IRQ=3,4,5,6,7,10,11,12;

10=3E8h; IRQ=3,4,5,6,7,10,11,12;

10=2E8h; IRQ=3,4,5,6,7,10,11,12;

COM1 422/485 control flow
Use this item to enable or disable serial port (COM) Autoflow
The optional settings are: Enabled, Disabled.

4-7-8 F17869 H/W Monitor

F17869 H/W Monitor

Press [Enter] to view PC health status.

This section shows the status of your CPU, Fan, and overall system.
This is only available when there is Hardware Monitor function onboard.
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4-7-9 F81216 Second Super 10 Configuration

Main Advanced Chipset Boot Security Save & Exit

F81216 Second Super 10 Configuration

F81216 Second Super 10 Chip
» Serial Port 3 Configuration
» Serial Port 4 Configuration
» Serial Port 5 Configuration
» Serial Port 6 Configuration

F81216 SecondIO

Set Parameters of Serial
Port 3(COMC)

—«: Select Screen
11: Select Item

Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Serial Port 3 Configuration
Please refer section 4-7-9-1

Serial Port 4 Configuration
Please refer section 4-7-9-1

Serial Port 5 Configuration
Please refer section 4-7-9-1

Serial Port 6 Configuration
Please refer section 4-7-9-1

4-7-9-1 Serial Port 3~6 Configuration

Main Advanced Chipset Boot Security Save & Exit

Serial Port 3~6 Configuration Enable or Disable Serial
Port (COM)

Serial Port [Enabled]

Device Settings 10=260h; IRQ=11;

Change Settings
COM3 422/485 control flow

[AUTO]
[Disabled]

—«: Select Screen
11: Select Item

Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

64




Serial Port
Use this item to enable or disable serial port (COM).
The optional settings are: Enabled, Disabled.

Change Settings

Use this item to select an optimal setting for super 10 device.
The optional settings are:

AUTO

10=260h; IRQ=11;

10=260h; IRQ=10,11,12;

10=268h; IRQ=10,11,12;

10=270h; IRQ=10,11,12;

10=278h; IRQ=10,11,12;

COM3 422/485 control flow
Use this item to enable or disable serial port Auto flow (COM).
The optional settings are: Enabled, Disabled.

4-7-10 Serial Port Console Redirection

Main Advanced Chipset Boot Security Save & Exit
Console Redirection [Disabled] Console Redirection
» Console Redirection Settings Enable or Disable.

—«—: Select Screen
11: Select Item

Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Console Redirection
Use this item to enable or disable Console Redirection.
The optional settings are: Enabled, Disabled.
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4-7-11 Network Stack

Main Advanced Chipset Boot Security Save & Exit

Network stack [Disable Link] Enable/Disable UEFI
network stack.

—«—: Select Screen
t1: Select Item

Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Network Stack
Enable/Disable UEFI network stack.
The optional settings are: Disable Link, Enable.

4-8 Chipset

Main Advanced Chipset Boot Security Save & Exit

» PCH-10 Configuration PCH Parameters
» System Agent (SA) Configuration

—«: Select Screen
11: Select Item

Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

PCH-10 Configuration
Please refer section 4-8-1

System Agent (SA) Configuration
Please refer section 4-8-2
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4-8-1 »PCH-10 Configuration

Main Advanced Chipset Boot Security Save & Exit
Intel PCH SKU Name QM77 PCI Express
Intel PCH Rev ID 04/C1 Configuration settings
» PCI Express Configuration —«: Select Screen
» USB Configuration 11: Select Item
»PCH Azalia Configuration Enter: Select
+/-: Change Opt.
. F1: General Help
Wake on LAN [Disabled] F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit
Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.
PCI Express Configuration
Please refer section 4-8-1-1
USB Configuration
Please refer section 4-8-1-2
PCH Azalia Configuration

Please refer section 4-8-1-3

Wake on LAN
Use this item to enable or disable integrated LAN to wake the system.

4-8-1-1 »PCI Express Configuration

Main Advanced Chipset Boot Security Save & Exit
PCI Express Configuration PCI Express
Configuration settings
» Mini PCle 1
» Mini PCle 2 —«: Select Screen
» PCl Express x1 11: Select Item
» PCl Express x1 Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Mini PCle 1
Please refer section 4-8-1-1-1

Mini PCle 2
Please refer section 4-8-1-1-1
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PCI Express x1

Please refer section 4-8-1-1-2

PCI Express x1
Please refer section 4-8-1-1-2

4-8-1-1-1 »Mini PCle 1/2

Main Advanced Chipset Boot Security Save & Exit
PCI Express Root Port 3/4 [Enabled] Control the PCI
PCle Speed [Gen1] Express Root Port.

—«—: Select Screen
11: Select ltem
Enter: Select
+/-: Change Opt.
F1: General Help
F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit
Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.
PCI Express Root Port 3/4
Control the PCI Express Root Port.
The optional settings are: Enabled, Disabled.

PCle Speed
Select PCI Express port speed.
The optional settings are: Auto, Genl, Gen2.

4-8-1-1-2 »PCl Express x 1

Main Advanced Chipset Boot Security Save & Exit
PCI Express Root Port 7/8 [Enabled] Control the PCI
PCle Speed [Gen1] Express Root Port.

—«: Select Screen
11: Select ltem
Enter: Select
+/-: Change Opt.
F1: General Help
F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit
Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.
PCI Express Root Port 7/8
Control the PCI Express Root Port.

The optional settings are: Enabled, Disabled.
|
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PCle Speed
Select PCI Express port speed.
The optional settings are: Auto, Genl, Gen2.

4-8-1-2 »USB Configuration

Main Advanced Chipset Boot Security Save & Exit

USB Configuration Enable or disable XHCI
Pre-Boot Driver support.

XHCI Pre-Boot Driver [Enabled]

XHCI Mode [Smart Auto] —«: Select Screen

HS Port #1 Switchable [Enabled] 11: Select Item

HS Port #2 Switchable [Enabled] Enter: Select

HS Port #3 Switchable [Enabled] +/- Change Opt.

HS Port #4 Switchable [Enabled] FL Gene_zral Help
F2: Previous Values

XHCI Streams [Enabled] F3: Optimized Defaults
F4: Save & Exit

EHCI1 [Enabled] Esc: Exit

EHCI2 [Enabled]

USB Ports Per-Port Disable Control [Disabled]

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

XHCI Pre-Boot Driver

Use this item to enable or disable XHCI Pre-Boot Driver Support.

xHCI Mode

Mode of operation of xHCI controller.

The optional settings are: Smart Auto, Enabled, Disabled.

HS Port #1 Switchable

HS Port #2 Switchable

HS Port #3 Switchable

HS Port #4 Switchable

Always for HS port switching between xHCI and EHCI. If disabled,

port is routed to EHCI. If HS port is routed to xHCI, the corresponding SS port is enabled.
The optional settings are: Disabled, Enabled.

xHCI Streams

Use this item to enable or disable xHCI Maximum Primary Stream Array Size.
The optional settings are: Disabled, Enabled.

EHCI1/ EHCI2

Use this item to enable or disable USB EHCI (USB 2.0) support.
One EHCI controller must always be enabled.

The optional settings are: Enabled, Disabled.
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USB Port Pre-Port Disable Control
Use this item to control each of the USB ports (0~13) disabling.
The optional settings are: Disabled, Enabled.

4-8-1-3 »PCH Azalia Configuration

Main Advanced Chipset Boot Security Save & Exit
PCH Azalia Congiguration Control Detection of the
Azalia device.
Azalia [Auto]
Azalia Internal HDMI Codec [Enabled] s« Select Screen
Azalia HDMI Codec [Enabled] 11: Select Item

Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Azalia
Use this item to enable, disable or auto control detection of the Azalia device.
Azalia Internal HDMI Codec

Use this item to enable or disable internal HDMI codec for Azalia.

Azalia HDMI Codec
Use this item to enable or disable internal HDMI codec Port for Azalia.

4-8-2 »System Agent (SA) Configuration

Main Advanced Chipset Boot Security Save & Exit
System Agent Bridge Name IvyBridge Config Graphics
System Agent RC Version 1.2.0.0 Settings.
—«—: Select Screen
» Graphics Configuration

11: Select Item

Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Graphics Configuration
Please refer section 4-8-2-1

70



4-8-2-1 » Graphics Configuration

Main Advanced Chipset Boot Security Save & Exit
Graphics Configuration Graphics turbo IMON
IGFX VBIOS Version 2170 current values supported
IGfx Frequency 350 MHz (14-31)
Graphics Turbo IMON Current 31
—«—: Select Screen
Aperture Size [256MB] 11: Select Item
DVMT Pre-Allocated [64M] Enter: Select
DVMT Total Gfx Mem [256M] +/-: Change Opt.
»LCD Control F1: General Help
F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit
Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.
Aperture Size
The optional settings are: 128MB,256MB,512MB.

DVMT Pre-Allocated
Use this item to select DVMT 5.0 pre-allocated (fixed) graphics memory size used by
the internal graphics device.

The optional settings are: 32/64/96/128/160/192/224/256/288/320/352/384/416/448/480/512/1024M
DVMT Total Gfx Mem

Use this item to select DVMT 5.0 total graphics memory size used by the internal graphics device.
The optional settings are:128M, 256M, MAX.

LCD Control
Please refer section 4-8-2-1-1
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4-8-2-1-1 » LCD Control

Main Advanced Chipset Boot Security Save & Exit
Graphics Configuration Select the Video
Device which will be
) ) activated during POST.
Primary IGFX Boot Dlspl_ay [CRT] This has no effect
Secondary IGFX Boot Display [LVDS] if external graphics
LCD Panel Type [1024x768 LVDS1] present. Secondary boot
Panel Color Depth [18 Bit] display selection will

appear based on your
selection. VGA modes
will be supported only on
primary display

—«: Select Screen
11: Select Item

Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Primary IGFX Boot Display

Select the Video Device which will be activated during POST. This has no effect if external
graphics present. Secondary boot display selection will appear based on your selection.
VGA modes will be supported only on primary display.

The optional settings are: VBIOS Default, CRT, HDMI, LVDS, DVI.

Secondary IGFX Boot Display
The optional settings are: Disabled, CRT, HDMI, LVDS, DVI.
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LCD Panel Type
This item allows you to select the panel resolution

1. VBIOS Default

2. 1024 X 600 LVDS
3. 800 X 600 LVDS
4, 1024 X 768 LVDS1
5. 1280 X 1024 LVDS
6. 1440 X 1050 (RB) LVDS1
7. 1440 X 1050 LVDS2
8. 1600 X 1200 LVDS
9. 1366 X 768 LVDS
10. 1680 X 1050 LVDS
11. 1920 X 1200 LVDS
12. 1440 X 900 LVDS
13. 1600 X 900 LVDS
14. 1024 X 768 LVDS2
15. 1280 X 800 LVDS
16. 1920 X 1080 LVDS
17. 2048 X 1536 LVDS

Panel Color Depth
Use this item to select the LFP Panel Color Depth 18Bit or 24Bit.

4-9 Boot
Main Advanced Chipset Boot Security Save & Exit
Boot Configuration Select the keyboard
Bootup NumLock State [on] NumLock state.
Quiet Boot [Enabled] —«: Select Screen
CSM16 Module Version 07.69 11: Select Item
GateA20 Active [Upon Request] Enter: Select
+/-: Change Opt.
Boot Option Priorities F1: General Help
F2: Previous Values
» CSM parameters F3: Optimized Defaults
F4: Save & Exit
Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Bootup NumLock State
Use this item to select keyboard NumLock State.
The optional settings are: On, Off.

___________________________________________________________________________|
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Quiet Boot

The optional settings are: Enabled, Disabled.

Gate A20 Active
UPON REQUEST- GA20 can be disabled using BIOS services.
ALWAYS- do not allow disabling GA20.

CSM parameters
Please refer section 4-9-1

4-9-1 CSM parameters

Main Advanced Chipset Boot Security Save & Exit
Boot option filter [Legacy only] This option controls what
Launch PXE OpROM policy [Do not launch] devices system can boot

to

—«: Select Screen
11: Select Item

Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Boot option filter
This option controls what devices system can boot to.
The optional settings are: UEFI and Legacy, legacy only, UEFI only.

Launch PXE OpROM policy
This option controls the execution of UEFI and Legacy PXE OpROM.
The optional settings are: Do not launch, UEFI only, Legacy only.
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4-10 Security

Main Advanced Chipset Boot Security

Password Description This option controls if
CSM will be launched

If ONLY the Administrator’s password is set,

Then this only limits access to Setup and is

only asked for when entering Setup.

If ONLY the User’s password is set, then this

is a power on password and must be entered to

Boot or enter Setup. In Setup the User will —>«: Select Screen

Have Administrator right. 11: Select Item

The password length must be Enter: Select

in the following range: +/-: Change Opt.

Minimum length 3 F1: General Help

Maximum length 20 F2: Previous Values

Administrator Password
User Password

F3: Optimized Defaults
F4: Save & Exit
Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Administrator Password & User Password

To set up an administrator password:

1. Select Administrator Password. The screen then pops up an Create New Password dialog.
2. Enter your desired password that is no less than 3 characters and no more than 20 characters.

3. Hit [Enter] key to submit.
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4-11 Save & Exit

Main Advanced Chipset Boot Security Save & Exit
Save Changes and Reset Reset the system after
Restore Defaults saving the changes.

Boot Override

—«: Select Screen
11: Select Item

Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Save Changes and Reset
This item allows user to reset the system after saving the changes.

Restore Defaults
Use this item to restore /load default values for all the setup options.
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Chapter-5

DRIVER INSTALLATION

There is a system installation DVD in the package. This DVD does not only include all the
drivers you need but also some other free application programs and utility programs.

In addition, this DVD also includes an auto detect software telling you which hardware is
installed and which driver is needed so that your system can function properly. We call this
auto detect software SYSTEM INSTALL.

SYSTEM INSTALL Supports Windows XP/

Windows 7/Windows 8/8.1

Insert the DVD into your DVD-ROM drive and the SYSTEM INSTALL menu should appear as below.
If the menu does not appear, double-click MY COMPUTER and double-click DVD-ROM drive or click
START, click RUN, and type X:\SETUP.EXE (assuming your DVD-ROM drive is X).

Make your selection from SYSTEM INSTALL menu:

1. Auto Detect Main board and OS to AUTOMATIC DRIVER INSTALLATION menu
2 . Browse DVD to view the contents of the DVD
3. Exitto exit SYSTEM INSTALL menu

77



AUTOMATIC DRIVER INSTALLATION menu

1. INF install Intel Ivy Bridge chipset driver
2. VGA install Intel onboard VGA driver

3. SOUND install HD Audio Codec driver

4. LAN to the LAN driver Readme file
5.COM to the COM driver Readme file

6. USB 3.0 install Intel USB 3.0 extensible Host Controller driver
Each selection is illustrated below:
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5-1 INF Install Intel Baytrail Chipset Driver

1. At the "AUTOMATIC DRIVER INSTALLATION 2. At the "Intel® Chipset Device Software"

menu" screen, click "INF". screen, click "Next".
3. At the "License Agreement" screen, 4. At the "Readme File Information" screen,
click "Yes" Click "Next".
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5. Click "Next" 6. Click "Finish" to restart computer

NOTE: SYSTEM INSTALL will auto detect file path

For Windows XP 64/32-bit, Windows 7 64/32-bit and windows 8 64/32-bit
X:\driven\INTELMIVY_SAN\inflinfinst_autol.exe

For Windows 8.1 64/32-bit
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5-2 VGA Install Intel lvy Bridge VGA Driver

Bl Intel(R) Graphics Driver Software - InstallShield Wizard =)

Production Version Releases

m

Microsoft Windows™ 7 64
Microsoft Windows™ 8 64

Driver Revision: 15.28.12.64.2932

December 13, 2012

* NOTE: This document refers to systems containing
the
*  folowing Intel(R) processors:

*  3rd generation Intel(R) Core(TM) i3 processor
*  3rd generation Intel(R) Core(TM) i5 processor

* 3rd generation Intel(R) Core(TM) i5 vPro(TM)

processar

= rd generation Intel(R) Core(TM) i7 processor -

Cancel

1. At the"AUTOMATIC DRIVER INSTALLATION 2. At the "Intel® HD Graphics Driver" screen,

menu"screen, click "VGA". Click "Next".
3. At the "Welcome to the Setup Program” 4. At the "License Agreement" screen,
screen, Click "Next". Click "Yes".
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5. At the "Readme File Information" screen, 6. At the "Setup Progress" screen,
Click "Next". Click "Next".

7. Click “Finish” to restart computer

NOTE: SYSTEM INSTALL will auto detect file path

For Windows XP 64bit
X:\drive\INTELMIVY_SAN\Wga\winxp64\winxp64_145110.exe
For Windows XP 32bit
X:\driver\INTEL\IVY_SAN\Wga\winxp\winxp_145110.exe

For Windows 7 64bit and Windows 8 64bit
X:\driver\INTEL\IVY_SAN\vga\ WIN_7_8 64\ win64_152812.exe
For Windows 7 32bit and Windows 8 32bit
X:\driver\INTEL\IVY_SAN\vga\ WIN_7_8_ 32\ win32_152812.exe
For Windows 8.1 64bit
X:\driver\INTEL\IVY_SAN\vga\WIN8.1\SAN\x64\ Setup.exe

For Windows 8.1 32bit
X:\driver\INTEL\IVY_SAN\vga\WIN8.1\SAN\x86\Setup.exe

___________________________________________________________________________|
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5-3 SOUND Install Realtek High Definition Audio Driver

1. At the "AUTOMATIC DRIVER INSTALLATION 2. Click "Next".
menu" screen, click "SOUND".

3. Click "Finish" to restart computer

NOTE: SYSTEM INSTALL will auto detect file path

For Windows XP 32/64 bit

X:\driver\INTEL\IVY_SAN\SOUND\WDM_R270.exe

For Windows 7 32/64 bit and Windows 8 32/64 bit
X:\driver\INTEL\IVY_SAN\SOUND\Vista_Win7_Win8_R270.exe

For Windows 8.1 32bit
X\driver\INTEL\IVY_SAN\SOUND\Win8.1\32bit_Win7_Win8_Win81_R273.exe
For Windows 8.1 64bit
X:\driver\INTEL\IVY_SAN\SOUND\Win8.1\64bit_Win7_Win8_Win81_R273.exe

___________________________________________________________________________|
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5-4 USB 3.0 Install Intel USB 3.0 extensible Host Controller Driver

1. At the "AUTOMATIC DRIVER 2. At the "Intel® USB 3.0 extensible Host
INSTALLATIONmenu" screen, Click "USB 3.0 Controller Driver" screen, Click" Next.

3. At the "License Agreement" screen, 4. At the "Readme File Information" screen,
Click "Yes". Click "Next".
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5. Click "Next". 6. Click "Finish" to restart computer

NOTE: The path of the file
For Windows 7 32/64-bit
X:\driver\INTELMIVY_SAN\USB3_O\INTEL\Setup.exe
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5-5 ME Install Intel Management Engine Interface Driver

1. Plaese Check Device Manager "PClI
Simple Communications Controllers”

License Agreement

You must accept all of the terms of the license agreement in order to continue the setup
program, Do you accept the terms?

\INTEL SOFTWARE LICENSE AGREEMENT (OEM / IHV / ISV Distribution & Single User)

IMPORTANT - READ BEFORE COPYING, INSTALLING OR USING.

Do nat use or load this software and any assodated materials (collectively, the Software”)
luntl you have carefully read the following terms and conditons. By loading or using the
Software, you agree to the terms of this Agreement. If you de not wish to so agree, do nat
install or use the Software.

Please Also Note:

* If you are an Original Equipment Manufacturer (OEM), Independent Hardware Vendor
(1HY), or Independznt Software Vendor (ISV), this complete LICENSE AGREEMENT applies;
* If you are an End-User, then only Exhibit A, the INTEL SOFTWARE LICENSE AGREEMENT,

<Back

3. At the "Setup Progress" screen,
Click "Next".

2. At the "Intel® Management Engine
Components"screen, Click" Next.

Intel® Installation Framework

Intel(R) Sideband Fabric

Setup Progress

Please wait while the following setup operations are performed:

Copying File: C:\Program Files {x86; MBI Driver\Uninstall\de-DEicense bt
Copying File: C:\Program Files {x86; ) MBI Driver\Uninstall\de-DE\setup. exe. dl
Copying File: C:\Program Files {x86; ) MBI Driver\Uninstall\da-DK Yicense. bt
Copying File: C:\Program Files {x86; MBI Driver\Uninstall\da-DK \setup. exe.
Copying File: C:\Program Files {x86; ) MBI Driver\ninstall\cs-CZ icense. bt
Copying File: C:\Program Files {x86; ) MBI Driver\Uninstall\cs-CZ\setup. exe.di
Copying File: C:\Program Files {x86; ) MBI Driver\Uninstall\ar-5A Yicense, bt
Copying File: C:\Program Files (x86; ) MBI Driver\Uninstall\ar-SA'setup. exe.di
Copying File: C:\Program Files (x86; MBI Driver\uni fg

Copying File: C:\Program Files (x86] ) MBI Driver \uri \Drv64.exe

Copying File: C:Windows\system32\difxapi.dl

Click Next to continue, v

4. Click "Next".
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5. At the "Readme File Information"screen, 6. At the "Setup Progress" screen,
Click "Next". Click "Next".

NOTE: The path of the file
For Windows XP 32/64 bit and Windows 7 32/64-bit
X:\driver\INTEL\ME TOOL\MEI-Only Installer\MEISetup.exe
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5-6 How to update Insyde BIOS

Step 1. To run afuwingui.exe then click "Open"

i AFUWINGUI v.1.09 (==

Information ‘ Setup ] Progress ]
System Information
0s Windows 7
Bios Size: 2621440 bytes
MainBios Size: 1703536 bytes
BootBlock Size: 655360 bytes
NVRAM Size: 262144 bytes
Core Version 0406
Project Version:  00.45
Firmware: D: Cl650049
Fimware GUID:  b5c530874eac-4b41-9d80730ba5aal70f

Bios Chip Mame: Winbond 25X/Q Series
ROM File: Information
Input Rom File:  Unknown

File Rom 1D: Unknown
File Rom GUID:  Unknown

American
Megatrends

Save Exit

Step 2. Click the new version BIOS (download from the website)
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Step 3. Choose "ProgramAll Blocks" and "Do Not Check ROM ID"

Step 4. Click "Flash"

Step 5. Click "Exit" and restart computer.

i AFUWINGUT v.1.09
Information | Setup ngmﬁl
—BIOS Map with ME Block(Each Block is 32K) Legend
51 3 e 2
=g| B g
< [ Erse
A 2 E [ Program
= B Verfy
=9 ’
I” Stage:
‘l"l[ Done.
IH Address:
FFFFFFFFh
Save I I Exit I

___________________________________________________________________________|
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Appendix A: Power Consumption Test

Condition
Iltem Spec
CPU i7-3610QE, i5-3610ME
Memory DDR3 1600 / 16GB

Operating System Windows 7

Test Program 3D Mark 11 Advanced Edition
HDD 3.5" SATA Standard HDD
HDD 2.5" SATA Slim Type HDD

Test Result for reference only !

Hard Disk Processor Power off - Start up Operatlon ShUt.down
Maximum Stable Maximum Maximum
i7-3610QE 0.1A 3.35A 1.52A 4.99A 2.33A
Standard HDD
i5-3610ME 0.1A 2.89A 1.45A 4.04A 2.36A
i7-3610QE 0.1A 2.98A 1.16A 4.81A 1.99A
Slim Type HDD
i5-3610ME 0.1A 2.54A 1.1A 3.75A 1.72A

The power consumption depends on your device choice!
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Appendix B: Resolution list

640 x 480 x (256 / 16bit/ 32bit)

800 x 600 x (256 / 16bit/32bit)

1024 x 768 x (256 / 16bit/ 32bit)

1152 x 864 x (256 / 16bit/ 32bit)

1280 x 600 x (256 / 16bit/ 32bit)

1280 x 720 x (256 / 16bit/ 32bit)

1280 x 768 x (256 / 16bit/ 32bit)

1280 x 800 x (256 / 16bit/ 32bit)

1280 x 960 x (256 / 16bit/ 32bit)

1280 x 1024 x (256 / 16bit / 32bit )

1400 x 1050 x ( 256 / 16bit / 32bit)

1440 x 900 x (256 / 16bit/ 32bit)

1600 x 900 x (256 / 16bit / 32bit )

1600 x 1200 x ( 256 / 16bit / 32bit )

1680 x 1050 x ( 256 / 16bit / 32bit )

1920 x 1080 x ( 256 / 16bit / 32bit )

1920 x 1200 x ( 256 / 16bit / 32bit )
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Appendix C: F75111N I’)C DIO device

1-1 10 Device:F75111 under DOS

The Sample code source you can download from

Source file: F75111_Dos_Src.rar http:/tprd.info/lexwiki/index.php/IO_Device:F75111_under_DOS
Binary file: F75111_Dos_Bin.rar

USERNAME & PASSWORD: sf
How to use this Demo Application

1.Boot Ms-Dos Operating System
2.execute "75WDT.EXE" binary file
3.Input 1 to Enable WDT timer or input O to Disable it.

4.input numbers of second for chip countdown and Reset Computer

Introduction
How to use this Demo Application

: Writel2CByte(I2CADDR, CONFIG, 0x03);//Set Watch Dog Timer function
: Writel2CByte(I2CADDR, WDT_TIMER, timer);//Set Watch Dog Timer range from 0-255.
: Writel2CByte(I2CADDR, WDT_TIMER_CTL, 0x73);//Enable Watch Dog Timer in second and pulse mode

void pause(int time)
{
asm mov ah,0h; //Ah =00 Read System Time Counter
asm int l1ah; /Iread time from Time Counter and store it in DX register
asm add dx,time;

label:
asm int lah;
asm cmp bx,dx;

1

1

1

1

1

1

1

1

1

1

1 asm mov bx,dx;
1

1

1

1

1

1

1 .

1 asm jne label;
1
1
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1-2 10 Device: F75111 under Windows
The Sample code source you can download from

Source file:F75111_DIO_Src_v2.7W.zip http://tprd.info/lexwiki/index.php/IO_Device:F75111
Binary file:F75111_DIO_Bin_v2.7W.zip

USERNAME & PASSWORD: sf

How to use this Demo Application

1. Press the "Start" button to test DIO function
. Press the "Enable" button to test WDT function
. Press the "Disable" button to disable WDT

. Check the "Enable Loop" box and press "Enable" to do WDT loop test

a A w N

. Press "Install WDT" to set the system to autorun this application when booting,
press again to remove this application when booting.

6. If WDT enable, system icon will be. if disable, system icon will ben

93



p.s.
f75111 send "F75111_SetWDTEnable(BYTE byteTimer)" including a parameter "timer",

if there's no disable signal (F75111_SetWDTDisable()) to stop it before timer countdown to 0, System will reboot.
if there's disable signal received, resent Enable WDT signal, for a loop to prevent from reboot

Introduction
Imtlal Internal F75111 port address (0x9c)

define GPIO1X, GPI0O2X, GPIO3X to input or output :
1 and Enable WDT function pin 1
Set F75111 DI/DO ( sample code as below Get Input value/Set output value)
: DO: InterDigitalOutput(BYTE byteValue)) :
| DI: InterDigitallnput() 1
Enable/DlsabIe WDT
. Enable : F75111_SetWDTEnable (BYTE byteTimer) :
. Disable: F75111_SetWDTDisable () 1
PULSE mode

Sample to setting GP33, 32, 31, 30 output 1mS low pulse signal.

this->Write_Byte(F75111_INTERNAL_ADDR, GPIO3X_PULSE_CONTROL, 0x00); //This is setting low pulse output
this->Write_Byte(F75111_INTERNAL_ADDR, GPIO3X_PULSE_WIDTH_CONTROL, 0x01); //This selects the pulse width to ImS

this->Write_Byte(F75111_INTERNAL_ADDR, GPIO3X_CONTROL_MODE, 0xQF); /IThis is setting the GP33, 32, 31, 30 to output function.
this->Write_Byte(F75111_INTERNAL_ADDR, GPIO3X_Output_Data , 0xQF); /IThis is setting the GP33, 32, 31, 30 output data.
}
b = = = e = e e = e = = e = a
Initial internal F75111
P om s e e e e e e e e e e e e e e e e e e e e e e e e e e === - "

void F75111::InitinternalF75111()

{
this->Write_Byte(F75111_INTERNAL_ADDR,GPIO1X_CONTROL_MODE ,0x00); /lset GPIO1X to Input function
this->Write_Byte(F75111_INTERNAL_ADDR,GPIO3X_CONTROL_MODE ,0x00); /lset GPIO3X to Input function

1

1

1

1

1

1

1

! this->Write_Byte(F75111_INTERNAL_ADDR,GPIO2X_CONTROL_MODE ,0xFF); lIset GP102X to Output function
1

1

1

1 this->Write_Byte(F75111_INTERNAL_ADDR,F75111_CONFIGURATION, 0x03); //Enable WDT OUT function
1
1



|
Set output value

1 void F75111::InterDigitalOutput(BYTE byteValue)

{

}

BYTE byteData = 0;

byteData = (byteData & 0x01 )? byteValue + 0x01 :
byteData = (byteData & 0x02 )? byteValue + 0x02 :
byteData = (byteData & 0x04 )? byteValue + 0x04 :
byteData = (byteData & 0x80 )? byteValue + 0x08 :
byteData = (byteData & 0x40 )? byteValue + 0x10 :
byteData = (byteData & 0x20 )? byteValue + 0x20 :
byteData = (byteData & 0x10 )? byteValue + 0x40 :
byteData = (byteData & 0x08 )? byteValue + 0x80 :

byteValue;
byteValue;
byteValue;
byteValue;
byteValue;
byteValue;
byteValue;
byteValue;

this->Write_Byte(F75111_INTERNAL_ADDR,GPIO2X_OUTPUT_DATA byteData);

Get Input value

I BYTE F75111::InterDigitalinput()

{

BYTE byteGPIO1X = 0;
BYTE byteGPIO3X = 0;
BYTE byteData =0;

this->Read_Byte(F75111_INTERNAL_ADDR,GPIO1X_INPUT_DATA &byteGPIO1X) ;
this->Read_Byte(F75111_INTERNAL_ADDR,GPIO3X_INPUT_DATA &byteGPIO3X) ;

byteGPIO1X = byteGPIOLX & OXFO;
byteGPIO3X = byteGPIO3X & OXOF;

byteData = ( byteGPIO1X & 0x10 )? byteData + 0x01 : byteData;

byteData = ( byteGPIO1X & 0x80 )? byteData + 0x02 : byteData;

byteData = ( byteGPIO1X & 0x40 )? byteData + 0x04 : byteData;

byteData = ( byteGPIO3X & 0x01 )? byteData + 0x08 : byteData;

byteData = ( byteGPIO3X & 0x02 )? byteData + 0x10 : byteData;

byteData = ( byteGPIO3X & 0x04 )? byteData + 0x20 : byteData;

byteData = ( byteGPIO3X & 0x08 )? byteData + 0x40 : byteData;

byteData = ( byteGPIO1X & 0x20 )? byteData + 0x80 : byteData;

return byteData;
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11 get value bit by bit

1l write byteData value via GPIO2X output pin

/I Get value from GPIO1X
/I Get value from GPIO3X

1l Mask unuseful value

1l Mask unuseful value

Il Get correct DI value from GPIO1X & GPIO3X
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Enable WatchDog

¥ void F75111_SetWDTEnable (BYTE byteTimer)

{

}

Disable WatchDog

! void F75111_SetwWDTDisable ()
{

1
1
1
1 WriteByte(F75111_INTERNAL_ADDR,WDT_CONFIGURATION,0x00);
1
1
-

WriteByte(F75111_INTERNAL_ADDR,WDT_TIMER_RANGE byteTimer);

/I set WatchDog range and timer

WriteByte(F75111_INTERNAL_ADDR,WDT_CONFIGURATION,WDT_TIMEOUT_FLAG | WDT_ENABLE | WDT_PULSE | WDT_PSWIDTH_100MS);

/I Enable WatchDog, Setting WatchDog configure

}
define F75111 pin in F75111.h
P = = = = = = = = = e e = = ==
L
1
1 #define  F75111_INTERNAL_ADDR 0x9C // OnBoard F75111 Chipset
1
| #define  F75111 EXTERNAL_ADDR Ox6E // External F75111 Chipset
1 //-
1
I #define  F75111_CONFIGURATION 0x03 // Configure GP1013 to WDT2 Function
1
VI
1
) #define  GPIO1X_CONTROL_MODE 0x10 // Select Output Mode or Input Mode
: #define GPI02X_CONTROL_MODE 0x20 // Select GPIO2X Output Mode or Input Mode
I #define GPIO3X_CONTROL_MODE 0x40 // Select GPIO3X Output Mode or Input Mode
1
VI
1
I#define GPIO1LX_INPUT_DATA 0x12 // GPIO1X Input
:#define GPIO3X_INPUT_DATA 0x42 /I GPIO3X Input
1/
1
1 #define  GPIO2X_OUTPUT_DATA 0x21 // GPIO2X Output
! /-
1
! 4define  GPIO1X_PULSE_CONTROL 0x13 // GPIO1x Level/Pulse Control Register
1
1 /I 0:Level Mode
1
1 /I 1:Pulse Mode
: #define  GPIO1X_PULSE_WIDTH_CONTROL 0x14 // GPIO1x Pulse Width Control Register
I #define  GP1_PSWIDTH_500US 0x00 // When select Pulse mode: 500 us.
1
1 #define GP1_PSWIDTH_1IMS 0x01 // When select Pulse mode: 1 ms.
1
) #define  GP1_PSWIDTH_20MS 0x02 // When select Pulse mode: 20 ms.
: #define GP1_PSWIDTH_100MS 0x03 // When select Pulse mode: 100 ms.
1y
1
1 #define GPIO2X_PULSE_CONTROL 0x23 /I GPIO2x Level/Pulse Control Register
1
1 I O:Level Mode
: /I 1:Pulse Mode
I #define  GPIO2X_PULSE_WIDTH_CONTROL 0x24 // GPIO2x Pulse Width Control Register
1
1 #define GP2_PSWIDTH_500US 0x00 // When select Pulse mode: 500 us.
1
1 #define GP2_PSWIDTH_1IMS 0x01 // When select Pulse mode: 1 ms.
: #define  GP2_PSWIDTH_20MS 0x02 // When select Pulse mode: 20 ms.
1 #define  GP2_PSWIDTH_100MS 0x03 // When select Pulse mode: 100 ms.
1
Vi
: #define GPIO3X_PULSE_CONTROL 0x43 // GPIO3x Level/Pulse Control Register
.

1/ Disable WatchDog
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0O:Level Mode

/I 1:Pulse Mode
#define  GPIO3X_Output_Data 0x41 /I GPIO3x Output Data Register
#define GPIO3X_PULSE_WIDTH_CONTROL 0x44 // GPIO3x Pulse Width Control Register
#define GP3_PSWIDTH_500US 0x00 // When select Pulse mode: 500
#define GP3_PSWIDTH_1MS 0x01 // When select Pulse mode: 1
#define GP3_PSWIDTH_20MS 0x02 // When select Pulse mode: 20
#define GP3_PSWIDTH_100MS 0x03 // When select Pulse mode: 100
I
#define WDT_TIMER_RANGE 0x37 /I 0-255 (secord or minute program by WDT_UNIT)
#define WDT_CONFIGURATION 0x36 // Configure WDT Function
#define WDT_TIMEOUT_FLAG 0x40 // When watchdog timeout.this bit will be set to 1.
#define WDT_ENABLE 0x20 // Enable watchdog timer
#define WDT_PULSE 0x10 // Configure WDT output mode

/I O:Level Mode

/I 1:Pulse Mode
#define  WDT_UNIT 0x08 // Watchdog unit select.

/I 0:Select second.

/I 1:Select minute.
#define  WDT_LEVEL 0x04 /I When select level output mode:

/I O:Level low

/I 1:Level high
#define WDT_PSWIDTH_1MS 0x00 // When select Pulse mode: 1
#define WDT_PSWIDTH_20MS 0x01 // When select Pulse mode: 20
#define WDT_PSWIDTH_100MS 0x02 // When select Pulse mode: 100
#define WDT_PSWIDTH_4000MS 0x03 // When select Pulse mode: 4
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1-3 10 Device: F75111 VB6 under Windows
The Sample code source you can download from

Source file: 75111_VB_v1.1l.rar http://tprd.info/lexwiki/index.php/IO_Device:F75111_VB6
Binary file: 75111 VB_Srcl.1l.rar

USERNAME & PASSWORD: sf

How to use this Demo Application

A Function - Choose your motherboard model

B Function - Enable WDT timer ,Key-in the value by seconds then system will reboot after
value which you key-in in left text box !!

C Function - Disable WDT timer ,Push down the button then WDT timer value will be clear !!

D Function - Set DO Value ,Key-in the DO value by hex then push the button !!

E Function - Check DI Value ,The right side two text box will display DI 1X & 2X Value when

you push down the button!!
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SDK Function Introduction
Functlon EnableWDT

: Function EnableWDT (timer As Integer) :

1 1

1

1 Call Writel2CByte(&H3, &H3) :

: Call Writel2CByte(&H37, timer) :

: Call Writel2CByte(&H36, &H73) :
1
1
1

1
: End Function

' Funcuon DisableWDT()

1
1
1
1
Call Writel2CByte(&H36, &HO0) :
1
1
1

End Function

Function SetDOValue

i Call WriteI2CByte(&H23, &H0)

| Call Write2CByte(&H20, &HFF)

1 Call Writel2CByte(&H2B, &HFF)

: Call Writel2CByte(&H21, dovalue)

Function SetDOValue(dovalue As Integer)

: End Function

. Funct|on CheckDIValue()

1 Dim GPIO1X  As Integer

: Dim GPIO3X  As Integer

: Dim DI1Xhex As String

: Dim DI3Xhex  As String

1

| Call Read|2CByte(&H12, GPIO1X)
! Call ReadI2CByte(&H42, GPIO3X)
1

1 DILXhex = Hex(GPIO1X)

! DI3Xhex = Hex(GPIO3X)

1

: Text3.Text = "0x" + DI1Xhex

| Text4.Text = "0x" + DI3Xhex

1
1 End Function
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1-4 10 Device: F75111 under linux

The Sample code source you can download from

Source file:F75111v2.3L_SRC.tar.gz nttp://tprd.info/lexwiki/index.php/I0_Device:F75111_under_linux
Binary file:F75111v2.3L_BIN.tar.gz

USERNAME & PASSWORD: sf

How to compile source code
1. Compile source code with Code::Blocks
download and install the Code::Block with command "apt-get install codeblocks"
Open an exist project(F75111.cbp) in Code::Blocks, click the compile button
(add an option 'pkg-config --libs gtk+-2.0 gthread-2.0' in "Project->Build Option->
Linker Setting->Other linker option")
2. Compile source code with "make"

l.cd F75111

1.make

1.src/f75111 // execute the binary file
How to use this Demo Application

. Press the "Start" button to test DIO function

. Press the "Enable" button to test WDT function

. Press the "Disable" button to disable WDT

. Check the "Enable Loop" box and press "Enable" to do WDT loop test

a A WO N BB

. Press "Install" to set the system to autorun this application when booting,

press "Uninstall" to remove this application when booting.

6. If WDT enable, system icon will be blinking.
|
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p.s.
f75111 send "F75111_SetWDTEnable(BYTE byteTimer)" including a parameter "timer",

if there's no disable signal (F75111_SetWDTDisable()) to stop it before timer countdown to 0, System will reboot.
if there's disable signal received, resent Enable WDT signal, for a loop to prevent from reboot p.s.

Introduction
IO function In file SMBus.c

' void SMBusloWrite(BYTE byteOffset,BYTE byteData)
' {

: outb( byteData , m_SMBusMaploAddr + byteOffset);
0

1

1

: BYTE SMBusloRead(BYTE byteOffset)

{
DWORD dwAddrVal;

1
1
1
1
1
: dwAddrVal = inb(m_SMBusMaploAddr + byteOffset);
1 return (BYTE)(dwAddrVal & 0xOFF);

1

1

: void F75111::InitinternalF75111()

this->Write_Byte(F75111_INTERNAL_ADDR,GPIO1X_CONTROL_MODE ,0x00); /Iset GPIO1X to Input function
this->Write_Byte(F75111_INTERNAL_ADDR,GPIO3X_CONTROL_MODE ,0x00); /Iset GPIO3X to Input function

this->Write_Byte(F75111_INTERNAL_ADDR,GPIO2X_CONTROL_MODE ,0xFF); /Iset GPIO2X to Output function

this->Write_Byte(F75111_INTERNAL_ADDR,F75111_CONFIGURATION, 0x03); /[Enable WDT OUT function

| BYTE byteData=0;

: byteData = (byteData & 0x01 )? byteValue + 0x01 : byteValue;
1 byteData = (byteData & 0x02 )? byteValue + 0x02 : byteValue;
: byteData = (byteData & 0x04 )? byteValue + 0x04 : byteValue;
! byteData = (byteData & 0x80 )? byteValue + 0x08 : byteValue;



byteData = (byteData & 0x40 )? byteValue + 0x10 : byteValue;
byteData = (byteData & 0x20 )? byteValue + 0x20 : byteValue;
byteData = (byteData & 0x10 )? byteValue + 0x40 : byteValue;
byteData = (byteData & 0x08 )? byteValue + 0x80 : byteValue; /I get value bit by bit

this->Write_Byte(F75111_INTERNAL_ADDR,GPIO2X_OUTPUT_DATA byteData); // write byteData value via GPIO2X output pin

: BYTE F75111::InterDigitallnput()

BYTE byteGPIO1X = 0;
BYTE byteGPIO3X = 0;
BYTE byteData =0;

this->Read_Byte(F75111_INTERNAL_ADDR,GPIO1X_INPUT_DATA &byteGPIO1X) ; // Get value from GPIO1X
this->Read_Byte(F75111_INTERNAL_ADDR,GPIO3X_INPUT_DATA &byteGPIO3X) ; // Get value from GPIO3X

byteGPIO1X = byteGPIO1X & OxFO; /I Mask unuseful value
byteGPIO3X = byteGPIO3X & 0xOF; /I Mask unuseful value

byteData = ( byteGPIO1X & 0x10 )? byteData + 0x01 : byteData;
byteData = ( byteGPIO1X & 0x80 )? byteData + 0x02 : byteData;
byteData = ( byteGPIO1X & 0x40 )? byteData + 0x04 : byteData;
byteData = ( byteGPIO3X & 0x01 )? byteData + 0x08 : byteData;

byteData = ( byteGPIO3X & 0x02 )? byteData + 0x10 : byteData;
byteData = ( byteGPIO3X & 0x04 )? byteData + 0x20 : byteData;
byteData = ( byteGPIO3X & 0x08 )? byteData + 0x40 : byteData;
byteData = ( byteGPIO1X & 0x20 )? byteData + 0x80 : byteData; /I Get correct DI value from GPIO1X & GPIO3X

return byteData;

: void F75111_SetWDTEnable (BYTE byteTimer)

1{

1 WriteByte(F75111_INTERNAL_ADDR,WDT_TIMER_RANGE ,byteTimer); 1/ set WatchDog range and timer

: WriteByte(F75111_INTERNAL_ADDR,WDT_CONFIGURATION,WDT_TIMEOUT_FLAG | WDT_ENABLE | WDT_PULSE | WDT_PSWIDTH_100MS);
1 /I Enable WatchDog, Setting WatchDog configure
'

Iv0|d F75111_SetWDTDisable ()

"

1

' WriteByte(F75111_INTERNAL_ADDR,WDT_CONFIGURATION,0x00); /I Disable WatchDog
1



:#define F75111_INTERNAL_ADDR ox9C /I OnBoard F75111 Chipset
:#define F75111_EXTERNAL_ADDR  Ox6E // External F75111 Chipset
vl
:#define F75111_CONFIGURATION 0x03 // Configure GPIO13 to WDT2 Function
W/
:#define GPIO1X_CONTROL_MODE 0x10 // Select Output Mode or Input Mode
1#define GPIO2X_CONTROL_MODE  0x20 // Select GPIO2X Output Mode or Input Mode
:#define GPIO3X_CONTROL_MODE  0x40 // Select GPIO3X Output Mode or Input Mode
://
1#define GPIO1X_INPUT_DATA 0x12 // GPIO1X Input
:#define GPIO3X_INPUT_DATA 0x42 /I GPIO3X Input
Vi
:#define GPIO2X_OUTPUT_DATA 0x21 /I GPIO2X Output
v/l
:#define GPIO2X_OUTPUT_DRIVING 0x2B // Select GPIO2X Output Mode or Input Mode
://

1#define WDT_TIMER_RANGE 0x37 /I 0-255 (secord or minute program by WDT_UNIT)

://

:#define WDT_CONFIGURATION 0x36 /I Configure WDT Function

:#define WDT_TIMEOUT_FLAG 0x40 // When watchdog timeout.this bit will be set to 1.
1#define WDT_ENABLE 0x20 // Enable watchdog timer

:#deﬁne WDT_PULSE 0x10 // Configure WDT output mode

: I 0:Level Mode

: I 1:Pulse Mode

1 #define WDT_UNIT 0x08 // Watchdog unit select.

: I 0:Select second.

: I 1:Select minute.

1#define WDT_LEVEL ox04 // When select level output mode:

: I O:Level low

, I 1:Level high

1#define WDT_PSWIDTH_1MS 0x00 // When select Pulse mode: 1 ms.
:#define WDT_PSWIDTH_20MS oxo1 // When select Pulse mode: 20 ms.
:#define WDT_PSWIDTH_100MS 0x02 // When select Pulse mode: 100 ms.

:#define WDT_PSWIDTH_4000MS 0x03 // When select Pulse mode: 4 S.
1/l
: typedef struct F75111_Address
H

' BYTE bAddress;
1JF75111_Address;

: F75111_Address m_F75111;

! bool F75111_Init();
1BYTE F75111_GetDigitallnput ();
: void F75111_SetDigitalOutput(BYTE byteValue);

IBYTE F75111_GetWDTMode();

1

1 void F75111_SetWDTMode(BYTE dwvalue);

1

1

:void F75111_SetWDTEnable (BYTE byteTimer);
1void F75111_SetWDTDisable ();






